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WARRANTY
The Anritsu product(s) listed on the title page is (are) warranted against defects in materials and
workmanship for one year from the date of shipment.
Anritsu’s obligation covers repairing or replacing products which prove to be defective during the
warranty period. Buyers shall prepay transportation charges for equipment returned to Anritsu for
warranty repairs. Obligation is limited to the original purchaser. Anritsu is not liable for consequential
damages.

LIMITATION OF WARRANTY
The foregoing warranty does not apply to Anritsu connectors that have failed due to normal wear. Also,
the warranty does not apply to defects resulting from improper or inadequate maintenance by the
Buyer, unauthorized modification or misuse, or operation outside of the environmental specifications of
the product. No other warranty is expressed or implied, and the remedies provided herein are the
Buyer’s sole and exclusive remedies.

DISCLAIMER OF WARRANTY 
DISCLAIMER OF WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE
LAW, ANRITSU COMPANY AND ITS SUPPLIERS DISCLAIM ALL WARRANTIES, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH REGARD TO THE
PRODUCT. THE USER ASSUMES THE ENTIRE RISK OF USING THE PRODUCT. ANY LIABILITY
OF PROVIDER OR MANUFACTURER WILL BE LIMITED EXCLUSIVELY TO PRODUCT
REPLACEMENT.
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL ANRITSU COMPANY OR ITS SUPPLIERS BE LIABLE
FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY
LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE PRODUCT, EVEN IF ANRITSU
COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME
STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY
NOT APPLY TO YOU.

TRADEMARK ACKNOWLEDGMENTS
Windows, Windows 2000, and Windows XP, are all registered trademarks of Microsoft Corporation.
Acrobat Reader is a registered trademark of Adobe Corporation.
VxWorks and WindML are registered trademarks of Wind River Systems, Inc.
NI is a trademark of the National Instruments Corporation.
Spectrum Master is a trademark of Anritsu Company.

NOTICE
Anritsu Company has prepared this manual for use by Anritsu Company personnel and customers as a
guide for the proper installation, operation and maintenance of Anritsu Company equipment and
computer programs. The drawings, specifications, and information contained herein are the property of
Anritsu Company, and any unauthorized use or disclosure of these drawings, specifications, and
information is prohibited; they shall not be reproduced, copied, or used in whole or in part as the basis
for manufacture or sale of the equipment or software programs without the prior written consent of
Anritsu Company. For the latest service and sales contact information in your area, please visit:
http://www.anritsu.com/contact.asp

http://www.anritsu.com/Contact.asp


  



CE Conformity Marking

Anritsu affixes the CE Conformity marking onto its conforming products in accordance with 
Council Directives of The Council Of The European Communities in order to indicate that 
these products conform to the EMC and LVD directive of the European Union (EU).

C-tick Conformity Marking

Anritsu affixes the C-tick marking onto its conforming products in accordance with the 
electromagnetic compliance regulations of Australia and New Zealand in order to indicate 
that these products conform to the EMC regulations of Australia and New Zealand.

Notes On Export Management

This product and its manuals may require an Export License or approval by the government 
of the product country of origin for re-export from your country.

Before you export this product or any of its manuals, please contact Anritsu Company to 
confirm whether or not these items are export-controlled.

When disposing of export-controlled items, the products and manuals need to be broken or 
shredded to such a degree that they cannot be unlawfully used for military purposes.
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Safety Symbols

To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu 
Company uses the following symbols to indicate safety-related information. For your own 
safety, please read the information carefully before operating the equipment.

Symbols Used in Manuals

Safety Symbols Used on Equipment and in Manuals
The following safety symbols are used inside or on the equipment near operation locations to 
provide information about safety items and operation precautions. Ensure that you clearly 
understand the meanings of the symbols and take the necessary precautions before operating 
the equipment. Some or all of the following five symbols may or may not be used on all 
Anritsu equipment. In addition, there may be other labels attached to products that are not 
shown in the diagrams in this manual.

This indicates a prohibited operation. The prohibited operation is indicated 
symbolically in or near the barred circle.

This indicates a compulsory safety precaution. The required operation is indicated 
symbolically in or near the circle.

This indicates a warning or caution. The contents are indicated symbolically in or 
near the triangle.

This indicates a note. The contents are described in the box.

These indicate that the marked part should be recycled.

Danger

This indicates a very dangerous procedure that could result in serious injury 
or death, or loss related to equipment malfunction, if not performed properly.

Warning This indicates a hazardous procedure that could result in light-to-severe 
injury or loss related to equipment malfunction, if proper precautions are not 
taken.

Caution

This indicates a hazardous procedure that could result in loss related to 
equipment malfunction if proper precautions are not taken.
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For Safety

Warning Always refer to the operation manual when working near locations at 
which the alert mark, shown on the left, is attached. If the operation, 
etc., is performed without heeding the advice in the operation 
manual, there is a risk of personal injury. In addition, the equipment 
performance may be reduced. Moreover, this alert mark is sometimes 
used with other marks and descriptions indicating other dangers.

Warning

When supplying power to this equipment, connect the accessory 
3-pin power cord to a 3-pin grounded power outlet. If a grounded 
3-pin outlet is not available, use a conversion adapter and ground the 
green wire, or connect the frame ground on the rear panel of the 
equipment to ground. If power is supplied without grounding the 
equipment, there is a risk of receiving a severe or fatal electric shock.

Warning

This equipment can not be repaired by the operator. Do not attempt to 
remove the equipment covers or to disassemble internal 
components. Only qualified service technicians with a knowledge of 
electrical fire and shock hazards should service this equipment. 
There are high-voltage parts in this equipment presenting a risk of 
severe injury or fatal electric shock to untrained personnel. In 
addition, there is a risk of damage to precision components.

Caution

Electrostatic Discharge (ESD) can damage the highly sensitive 
circuits in the instrument. ESD is most likely to occur as test devices 
are being connected to, or disconnected from, the instrument’s front 
and rear panel ports and connectors. You can protect the instrument 
and test devices by wearing a static-discharge wristband. 
Alternatively, you can ground yourself to discharge any static charge 
by touching the outer chassis of the grounded instrument before 
touching the instrument’s front and rear panel ports and connectors. 
Avoid touching the test port center conductors unless you are 
properly grounded and have eliminated the possibility of static 
discharge. 
Repair of damage that is found to be caused by electrostatic 
discharge is not covered under warranty.

Warning This equipment is supplied with a rechargeable battery that could potentially 
leak hazardous compounds into the environment. These hazardous 
compounds present a risk of injury or loss due to exposure. Anritsu 
Company recommends removing the battery for long-term storage of the 
instrument and storing the battery in a leak-proof, plastic container. Follow 
the environmental storage requirements specified in the product data sheet.



Spectrum Master UG PN: 10580-00277  Rev. E Contents-1

Table of Contents

Chapter 1—General Information

1-1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1

1-2 Contacting Anritsu       . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1

1-3 Available Models. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2

1-4 Available Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2

1-5 Standard and Optional Accessories . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3

1-6 Additional Documents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4

1-7 Instrument Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4

1-8 Spectrum Master Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5

1-9 Calibration Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5

1-10 Preventive Maintenance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5

1-11 ESD Cautions    . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6

1-12 Anritsu Reference Documents   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-7

1-13 Anritsu Service Centers     . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-7

1-14 Battery Replacement   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-8

1-15 Soft Carrying Case . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-9

1-16 Tilt Bail Stand   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-10

1-17 Secure-Environment Workplace  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-10

Option 7, Secure Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-10

Spectrum Master Memory Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-11

Erase All User Files in Internal Memory   . . . . . . . . . . . . . . . . . . . . . . 1-12

Recommended Usage in a Secure Environment  . . . . . . . . . . . . . . . . 1-12

Chapter 2—Instrument Overview

2-1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1

2-2 Hardware Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2

Turning On the MS272xC for the First Time . . . . . . . . . . . . . . . . . . . . . 2-2

2-3 Front Panel Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3

2-4 Front Panel Keys   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-4

Main Menu Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-5

Submenu Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-5

2-5 Mode Selector Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-6

2-6 Secondary Function Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-7

2-7 Display Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8

Spectrum Analyzer Mode         . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8



Contents-2 PN: 10580-00277  Rev. E Spectrum Master UG

2-8 Parameter Setting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-9

2-9 Text Entry   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-9

2-10 Connector Care. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-12

Connecting Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-12

Disconnecting Procedure. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-12

2-11 Test Panel Connectors      . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-13

2-12 Symbols and Indicators. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-15

2-13 Firmware Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-17

Main Menu Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-17

Submenu Keys  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-17

Chapter 3—Quick Start Guide

3-1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1

3-2 Measurement Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2

Connect the Input Source  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2

Editing and Entering Values  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2

Selecting the Analyzer Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2

3-3 Set the Measurement Frequency   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3

Using Start and Stop Frequencies  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3

Entering Center Frequency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3

Selecting Signal Standard    . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3

Setting Measurement Frequency Bandwidth    . . . . . . . . . . . . . . . . . . . 3-3

3-4 Set the Amplitude   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-5

Setting Amplitude Reference Level and Scale  . . . . . . . . . . . . . . . . . . . 3-5

Setting Amplitude Range and Scale . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-5

Reference Level Offset for External Loss or External Gain . . . . . . . . . . 3-6

3-5 Set the Span  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6

3-6  Setting Up Limit Lines   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7

Simple Limit Line . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7

Limit Line Envelope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7

Complex Limit Lines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8

3-7 Setting Up Markers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9

3-8 Selecting a Measurement Type  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10



Spectrum Master UG PN: 10580-00277  Rev. E Contents-3

3-9 Saving Measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10

3-10 Master Software Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10

Chapter 4—File Management

4-1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-1

4-2 Managing Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-1

Save Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-1

Recall Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2

Recall Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2

Copying Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-3

Deleting Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-5

Delete Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-5

4-3 File Menu Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-6

4-4 File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-7

Save Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-8

Save Location Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-9

Save On Event Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-10

Recall Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-11

Copy Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-12

Delete Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-13

Chapter 5—System Operation

5-1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-1

5-2 System Menu Overview   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-2

5-3 System Menu   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-3

System Options Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-4

System Options 2/2 Menu    . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-5

Display Settings Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-6

Reset Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-7

5-4 Preset Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-8

5-5 Power On Self Test  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-8

5-6 Update Firmware  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-9

Using a USB Memory Device   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-9

Update Firmware Using Master Software Tools . . . . . . . . . . . . . . . . . 5-11

Chapter 6—GPS (Option 31)



Contents-4 PN: 10580-00277  Rev. E Spectrum Master UG

6-1 Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-1

6-2 Setting Up GPS (Option 31)   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-1

Activating the GPS Feature . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-1

Chapter 7—Master Software Tools 

7-1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-1

7-2 Master Software Tools Overview   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-1

7-3 MST Feature Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-1

7-4 Installing MST . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-2

7-5 Updating Instrument Firmware   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-2

Update Firmware by Using a USB Device. . . . . . . . . . . . . . . . . . . . . . . 7-6

Appendix A—Measurement Guides

A-1 Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .A-1

A-2 Documents, Firmware, Supplemental Information . . . . . . . . . . . . . . . . . . .A-1

Appendix B—Error Messages

B-1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-1

B-2 Self Test or Application Self Test Error Messages  . . . . . . . . . . . . . . . . . .B-1

B-3 Operation Error Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-2

Appendix C—LAN and DHCP

C-1 Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-1

C-2 Ethernet Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-1

LAN Connection  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-1

Ethernet Config . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-3

Ethernet Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-4

C-3 DHCP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-5

Example 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-5

Example 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-6

C-4 ipconfig Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-6

C-5 Ping Tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-7

Index



Spectrum Master UG PN: 10580-00277  Rev. E 1-1

Chapter 1 — General Information

1-1 Introduction
This chapter provides a description of the handheld Anritsu Spectrum Master models 
MS2722C, MS2723C, MS2724C, MS2725C, and MS2726C, referred to collectively as model 
series MS272xC. It also briefly describes preventive maintenance, calibration requirements, 
ESD cautions, and additional documents. 

General and performance specifications, instrument options, standard accessories, and 
optional accessories are in the Spectrum Master Technical Data Sheets: 

• PN: 11410-00529 for MS2722C

• PN: 11410-00524 for MS2723C

• PN: 11410-00525 for MS2724C

• PN: 11410-00526 for MS2725C

• PN: 11410-00527 for MS2726C

Refer to Appendix A, “Measurement Guides”, for additional information. Throughout this 
manual, these instruments may be referred to as a Spectrum Master or as a model MS2722C, 
MS2723C, MS2724C, MS2725C, MS2726C, or as model MS272xC.10580-00277

1-2 Contacting Anritsu      
To contact Anritsu, please visit:

http://www.anritsu.com/contact.asp 

From here, you can select the latest sales, select service and support contact information in 
your country or region, provide online feedback, complete a "Talk to Anritsu" form to have 
your questions answered, or obtain other services offered by Anritsu.

Updated product information can be found on the Anritsu web site:

http://www.anritsu.com/

Search for the product model number. The latest documentation is on the product page under 
the Library tab.

Example URL for MS2722C:

http://www.anritsu.com/en-us/products-solutions/products/MS2035B.aspx    

http://www.anritsu.com/contact.asp
http://www.anritsu.com/
http://www.anritsu.com/en-us/products-solutions/products/MS2722C.aspx
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1-3 Available Models
Table 1-1 lists the Spectrum Master models and frequency range described in this 
User Guide. 

1-4 Available Options
Available options for the Spectrum Master is shown in Table 1-2.

Table 1-1. Spectrum Master Model

Model  Frequency Range

MS2722C Spectrum Analyzer, 9 kHz to 9 GHz

MS2723C Spectrum Analyzer, 9 kHz to 13 GHz

MS2724C Spectrum Analyzer, 9 kHz to 20 GHz

MS2725C Spectrum Analyzer, 9 kHz to 32 GHz

MS2726C Spectrum Analyzer, 9 kHz to 43 GHz

Table 1-2. Available Options (Sheet 1 of 2)

MS2722C-xxxx
MS2723C-xxxx
MS2724C-xxxx
MS2725C-xxxx
MS2726C-xxxx Description

0007 Secure Data Operation

0019 High-Accuracy Power Meter (sensor not included)

0031 GPS Receiver (Requires GPS Antenna 2000-1528-R) 

0025 Interference Analyzer

0027 Channel Scanner

0089 Zero-Span IF Output

0009 I/Q Demodulation Hardware

0040 GSM/GPRS/EDGE RF Measurements(1)

0041 GSM/GPRS/EDGE Demodulation(1)

0035 W-CDMA/HSDPA Over-the-Air Measurements(2)

0044 W-CDMA/HSDPA RF Measurements(1)

0045 W-CDMA Demodulation (mutually exclusive with 0065)(1)

0065 W-CDMA/HSDPA Demodulation (mutually exclusive with 0045)(1)

0038 TD-SCDMA/HSDPA Over-the-Air Measurements(1)

0060 TD-SCDMA/HSDPA Measurements(1)

0061 TD-SCDMA/HSDPA Demodulation(1)
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1.  Requires Option 0009. 
2.  Requires Option 0009 and Option 0031. 

1-5 Standard and Optional Accessories
The Spectrum Master Technical Data Sheet listed in Section 1-1 contains a list and 
description of available accessories. The data sheet is available on the Anritsu web site: 
http://www.anritsu.com.

0541 LTE RF Measurements(1)

0542 LTE Modulation Measurements(1)

0543 LTE Bandwidths 15 MHz and 20 MHz (requires option 0541, 0542, 0551 or 
0552)

0546 LTE Over-the-Air Measurements(1)

0551 TD-LTE RF Measurements(1)

0552 TD-LTE Modulation Measurements(1)

0556 TD-LTE Over-the-Air Measurements(1)

0033 cdmaOne/CDMA2000 1X Over-the-Air Measurements(2)

0042 cdmaOne/CDMA2000 1X RF Measurements(1)

0043 cdmaOne/CDMA2000 1X Demodulation(1)

0062 CDMA2000 1xEV-DO RF Measurements(1)

0063 CDMA2000 1xEV-DO Demodulation(1)

0034 CDMA2000 1xEV-DO Over-the-Air Measurements(2)

0046 IEEE 802.16 Fixed WiMAX RF Measurements(1)

0047 IEEE 802.16 Fixed WiMAX Demodulation(1)

0037 IEEE 802.16 Mobile WiMAX Over-the-Air Measurements(1)

0066 IEEE 802.16 Mobile WiMAX RF Measurements(1)

0067 IEEE 802.16 Mobile WiMAX Demodulation(1)

0509 AM/FM/PM Analyzer

0098 Standard Calibration to Z540

0099 Premium Calibration to Z540 plus test data

Table 1-2. Available Options (Sheet 2 of 2)

MS2722C-xxxx
MS2723C-xxxx
MS2724C-xxxx
MS2725C-xxxx
MS2726C-xxxx Description

http://www.anritsu.com
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1-6 Additional Documents 
This user guide is specific to the Spectrum Master MS272xC (models MS2722C, MS2723C, 
MS2724C, MS2725C, and MS2726C). Additional instrument functions and descriptions of 
optional measurement capabilities are described in measurement guides. Refer to 
Appendix A, “Measurement Guides” for a list of these guides and their Anritsu part numbers. 
Measurement guides are provided on the Documentation disc that is shipped with the 
instrument and are also available for download (at no charge) from the Anritsu web site. 
Refer to section “Anritsu Reference Documents” on page 1-7.

1-7 Instrument Description
The Spectrum Master is a synthesizer-based handheld spectrum analyzer that provides quick 
and accurate measurement results. Measurements can be easily made by using the main 
instrument functions: frequency, span, amplitude, and bandwidth. Dedicated keys for 
common functions and a familiar calculator-type keypad are available for fast data entry.

Time and date stamping of measurement data is automatic. The internal memory provides 
for the storage and recall of up to 1000 measurement setups and up to 1000 traces using 
Master Software Tools (MST). External storage can be used for bulk measurement storage. 
The bright daylight-viewable, high-resolution, color liquid crystal display (LCD) provides 
easy viewing in a variety of lighting conditions. The Spectrum Master is capable of up to 
2.5 hours of continuous operation from a fully charged battery and can be operated from a 
12 VDC source, which also simultaneously charges the battery. 

The Spectrum Master is designed for monitoring, measuring, and analyzing signal 
environments. Typical measurements include: in-band interference and transmit spectrum 
analysis, plus cell site and 802.11a/b/g interference testing. Options are available for RF, 
advanced demodulation, and over-the-air (OTA) measurement. A full range of marker 
capabilities (such as peak, center, and delta functions) are provided for faster, more 
comprehensive analysis of displayed signals. Upper and lower multi-segmented limit lines 
are available to create quick, simple pass/fail measurements. A menu option provides for an 
audible alert when a limit value is exceeded.

In transmitter analyzer mode, the Spectrum Master displays six markers and the marker 
table in Code Domain Power and Codogram displays. In Spectrum Analyzer mode, a full 
range of marker capabilities is provided. Markers are not available in GSM mode.

Anritsu Master Software Tools, a PC-based software program, provides for storing 
measurement data. Master Software Tools can also convert the Spectrum Master display into 
several graphic formats.
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Measurements may be stored in the internal memory or a USB flash drive. Stored 
measurements can be downloaded to a PC by using the included USB and Ethernet cables. 
After being stored, the graphic trace can then be displayed, scaled, or enhanced with markers 
and limit lines. Historical graphs can be overlaid with current data by using the PC mouse in 
drag-and-drop fashion. The underlying data can be extracted and used in spreadsheets or for 
other analytical tasks.

1-8 Spectrum Master Specifications
Refer to the Technical Data Sheet listed in Section 1-1 for general specifications, detailed 
measurement specifications for all available measurement modes, ordering information, 
power sensors, and available accessories. The data sheet is included with the instrument and 
also available on the Anritsu web site: http://www.anritsu.com.

1-9 Calibration Requirements  
The Spectrum Master loads factory calibration data during start-up, eliminating the need for 
daily calibration checks. In WCDMA modes, an additional automatic calibration is performed 
as the internal temperature of the Spectrum Master changes (to insure the best possible 
measurement results).

Although the Spectrum Master does not require daily field calibration, Anritsu Company 
recommends annual calibration and performance verification by local Anritsu service centers.

1-10 Preventive Maintenance  
Spectrum Master preventive maintenance consists of cleaning the unit and inspecting and 
cleaning the RF connectors on the instrument and on all accessories. Clean the 
Spectrum Master with a soft, lint-free cloth that is dampened with water or with water and a 
mild cleaning solution. 

Clean the RF connectors and center pins with a cotton swab dampened with denatured 
alcohol. Visually inspect the connectors. The fingers of N(f) connectors and the pins of N(m) 
connectors should be unbroken and uniform in appearance. If you are unsure whether the 
connectors are good, then gauge the connectors to confirm that their dimensions are correct.

Visually inspect test port cables. Test port cables should be uniform in appearance, not 
stretched, kinked, dented, or broken.

Note

Not all USB drives are compatible with the instrument. Many drives come with a 
second partition that contains proprietary firmware. This partition must be 
removed. Only one partition is allowed. Refer to the individual manufacturer for 
instructions on how to remove it. Some drives can be made to work by reformatting 
them using the FAT32 format.

Caution To avoid damage to the display or case, do not use solvents or abrasive cleaners.

http://www.anritsu.com
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1-11 ESD Cautions   
The MS272xC, like other high performance instruments, is susceptible to ESD (electrostatic 
discharge) damage. Coaxial cables and antennas often build up a static charge, which may 
damage the MS272xC input circuitry (if allowed to discharge by connecting directly to the 
MS272xC without previously discharging the static charge). MS272xC operators must be 
aware of the potential for ESD damage and take all necessary precautions.

Operators should exercise practices outlined within industry standards such as JEDEC-625 
(EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices, 
equipment, and practices. Because these apply to the MS272xC, Anritsu Company 
recommends that any static charges that may be present be dissipated before connecting 
coaxial cables or antennas to the MS272xC. This may be as simple as temporarily attaching a 
short or load device to the cable or antenna prior to attaching to the MS272xC. Remember 
that the operator may also carry a static charge that can cause damage. Following the 
practices outlined in the above standards ensures a safe environment for both personnel and 
equipment.



Anritsu Reference Documents

Spectrum Master UG PN: 10580-00277  Rev. E 1-7

1-12 Anritsu Reference Documents  
The following URL is an Internet link to the Spectrum Master product page. 

Spectrum Master product page link: http://www.us.anritsu.com/SpectrumMaster 

A table at the bottom of each Spectrum Master web page presents Internet links to related 
literature and software. Examples include the following types of documents:

• Application Notes 

• Brochures 

• Data Sheets 

• Instruction Sheets 

• Technical Notes 

• White Papers 

• Master Software Tools

1-13 Anritsu Service Centers    
For the latest service and sales information in your area, please visit the following URL:

http://www.anritsu.com/Contact.asp 

and choose a country for regional contact information.

http://www.us.anritsu.com/SpectrumMaster
http://www.anritsu.com/Contact.asp
http://www.us.anritsu.com/SpectrumMaster
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1-14 Battery Replacement  
The battery can be replaced without the use of tools. The battery compartment is located on 
the lower left side of the instrument (when you are facing the measurement display). Slide 
the battery door down, towards the bottom of the instrument, to remove it. Remove the 
battery pack from the instrument by pulling straight out on the battery lanyard. Replacement 
is the opposite of removal.   

The battery that is supplied with the Spectrum Master may need charging before use. The 
battery can be charged while it is installed in the Spectrum Master by using either the 
AC-DC Adapter or the 12-Volt DC adapter, or separately in the optional Dual Battery 
Charger. Refer to section “Symbols and Indicators” on page 2-15 for a description of battery 
symbols.  

Figure 1-1. Battery Compartment Door 

Note Use only Anritsu approved batteries, adapters, and chargers with this instrument.

Caution 

When using the Automotive Cigarette Lighter Adapter, always verify that the 
supply is rated for a minimum of 60 Watts @ 12 VDC, and that the socket is clear 
of any dirt or debris. If the adapter plug becomes hot to the touch during operation, 
then discontinue use immediately.

Note 
Anritsu Company recommends removing the battery for long-term storage of the 
instrument.

Battery
Compartment
Door
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1-15 Soft Carrying Case
The instrument can be operated while in the soft carrying case. On the back of the case is a 
large storage pouch for accessories and supplies. 

To install the instrument into the soft carrying case:

1. The front panel of the case is secured with hook-and-loop fasteners. Fully close the front 
panel of the case. When closed, the front panel supports the shape of the case while you 
are inserting the Spectrum Master.

2. Place the soft carrying case face down on a stable surface, with the front panel fully 
closed and laying flat.

3. Fully open the zippered back of the case. 

4. Insert the instrument face down into the case, taking care that the connectors are 
properly situated in the case top opening. You may find it easier to insert the 
connectors first, then pull the corners over the bottom of the Spectrum Master. 

5. Close the back panel and secure with the zipper. 

The soft carrying case includes a detachable shoulder strap, which can be connected to the 
D-rings on the upper corners of the case, as required for comfort or convenience.

Note

Two zippers provide access around the back of the case. The zipper closer to the 
front of the case opens the case back, and allows access to install and remove the 
instrument. The zipper closer to the back of the case opens a support panel that 
can be used to provide support for improved stability and air flow while the 
instrument is in the case. This support panel also contains the storage pouch.

Figure 1-2. Instrument Inserted Into the Soft Carrying Case



Secure-Environment Workplace

1-10 PN: 10580-00277  Rev. E Spectrum Master UG

1-16 Tilt Bail Stand   
The attached Tilt Bail can be used for desktop operation. The tilt bail provides a backward tilt 
for improved stability and air flow. To deploy the tilt bail, pull the bottom of the tilt bail away 
from the back of the instrument. To store the tilt bail, push the bottom of the bail towards the 
back of the instrument and snap the bail into the clip on the back of the instrument.

1-17 Secure-Environment Workplace 
This section describes the Option 7 and Frequency Blanking, types of memory in the 
Spectrum Master, how to delete stored user files in internal memory, and recommended 
usage in a secure-environment workplace.

Option 7, Secure Data

Option 7, Secure Data will set the instrument to allow saving information to only an external 
USB flash drive. Saving to the internal memory is disabled. When Option 7 is installed, itis 
always On. It can be disabled only if a Service Center or other repair facility removes 
Option 7 from the instrument. 

Frequency Blanking

Option 7 allows the user to hide the displayed frequency values. Frequency values displayed 
on the screen and menus are replaced with ##.####. To enable frequency blanking press the 
Shift key, then the System (8) key. Press the System Options submenu key, then the Reset 
submenu key. Press the Frequency Blanking submenu key so that On is underlined. Setting 
Frequency Blanking back to Off will preset the instrument to factory default settings.  

After frequency blanking is enabled the user is not able to restore the frequency readouts. 
Following is a list of the security measures that have been taken to protect the frequency 
information after Frequency Blanking is turned on.

1. Turning off frequency blanking presets the instrument (and the frequencies) to the 
factory default settings.

2. Turning off the instrument presets the instrument to the factory default settings and 
turns off frequency blanking.

3. Presetting the instrument turns off frequency blanking and restores the factory default 
settings.

4. Frequency blanking is available only with Option 7 to ensure that user files and 
calibration files are not stored in the internal memory of the instrument.

Caution  

Note that even with Option 7 enabled, operating parameters (such as frequency 
range and power level) that are set by the user are stored in the Spectrum Master 
EEPROM when the Spectrum Master is turned OFF. These parameters can be 
erased, however, via a Master Reset operation, as described later in this chapter.
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Spectrum Master Memory Types

The instrument contains non-volatile disk-on-a-chip memory, EEPROM, and volatile DRAM 
memory. The instrument does not have a hard disk drive or any other type of volatile or 
non-volatile memory.

EEPROM

This memory stores the model number, serial number, and calibration data for the 
instrument. Also stored here are the user-set operating parameters, such as frequency range. 
During the master reset process, all operating parameters that are stored in the EEPROM 
are set to standard factory default values.

RAM Memory

This is volatile memory that is used to store parameters that are needed for the normal 
operation of the instrument along with current measurements. This memory is reset 
whenever the instrument is restarted.

External USB Flash Drive (not included with the instrument)

This memory may be selected as the destination for saved measurements and setups for the 
instrument. You can also copy the contents of the internal disk-on-chip memory to the 
external flash memory for storage or data transfer. The external Flash USB can be 
reformatted or sanitized using software on a PC. 

Refer to the Chapter 4, “File Management” for additional information about saving and 
copying files to the USB flash drive.

Warning

Note that when Frequency Blanking is turned on user files can still be stored and 
saved to an external USB drive, and that frequency information is not blanked in 
those files. Also, frequency information is not blanked from the SCPI commands 
that are used to remotely control the instrument. 
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Erase All User Files in Internal Memory  

Perform a Master Reset:

1. Turn on the instrument.

2. Press the Shift button then the System (8) button.

3. Press the System Options submenu key.

4. Press the Reset key, then the Master Reset key.

5. A dialog box will be displayed on the screen warning that all settings will be returned to 
factory default values, and that all user files will be deleted. This deletion is a standard 
file delete and does not involve overwriting exiting information.

6. Press the Enter button to complete the master reset.

7. The instrument reboots, and the reset is complete.

Recommended Usage in a Secure Environment

The Spectrum Master does not currently provide a secure erase feature. In environments 
where data security is an issue, Anritsu Company recommends that you store your 
Spectrum Master-created files on an external USB Flash drive that is then securely retained, 
sanitized, or destroyed after use. 

To set the Spectrum Master to save files to an external USB Flash drive:

1. Attach the external Flash drive and turn on the instrument.

2. Press the Shift button then the File (7) button.

3. Press the Save submenu key. 

4. Press the Change Save Location and using the arrow keys or rotary knob, select the 
location on the USB drive where the files are to be saved.

5. Press the Set Location submenu key.

6. Press Esc to clear the Save dialog box.

The external USB drive location is now the default location for saving files.

Note

Not all USB drives are compatible with the instrument. Many drives come with a 
second partition that contains proprietary firmware. This partition must be 
removed. Only one partition is allowed. Refer to the individual manufacturer for 
instructions on how to remove it. Some drives can be made to work by reformatting 
them using the FAT32 format.
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Chapter 2 — Instrument Overview

2-1 Introduction
This chapter provides a brief overview of the Anritsu MS272xC Spectrum Master. The intent 
of this chapter is to acquaint you with the instrument. To begin using the instrument 
immediately, go to Chapter 3, “Quick Start Guide”, to find directions for power on, editing, 
frequency, bandwidth, amplitude, limit line, marker, file management procedures, and 
firmware update. For more detailed information on measurement setups, refer to the specific 
measurement guides, which are based on the options that can be purchased for this 
instrument. The measurement guides and a copy of this user guide are available as PDF files 
on the Documentation disc or the Anritsu web site (http://www.anritsu.com). Refer to 
Appendix A, “Measurement Guides”.

http://www.anritsu.com
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2-2 Hardware Overview

Turning On the MS272xC for the First Time

The Anritsu MS272xC Spectrum Master is capable of approximately 2.5 hours of continuous 
operation from a fully charged, field-replaceable battery (refer to Section “Battery 
Replacement” on page 1-8 of Chapter 1). The MS272xC can also be operated from a 12 VDC 
source (which will also simultaneously charge the battery). This can be achieved with either 
the Anritsu AC–DC Adapter or Automotive Cigarette Lighter Adapter. Both items are 
included as standard accessories (refer to the list of accessories in the Technical Data Sheet 
for your specific instrument, as listed in section “Introduction” on page 1-1). 

To turn on the MS272xC, press the On/Off button on the front panel (Figure 2-1). 

The MS272xC Spectrum Master takes approximately forty seconds to complete power-up and 
to load the application software. At the completion of this process, the instrument is ready to 
be used.

Caution 

When using the Automotive Cigarette Lighter Adapter, always verify that the 
supply is rated for a minimum of 60 Watts at 12 VDC and that the socket is clear of 
any dirt or debris. If the adapter plug becomes hot to the touch during operation, 
then discontinue use immediately.

Figure 2-1. MS272xC On/Off Button

On/Off Button
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2-3 Front Panel Overview
The Spectrum Master menu-driven interface is easy to use and requires little training. Hard 
keys on the front panel are used to initiate function-specific menus. Five main menu keys are 
located below the display. These keys vary in function depending upon the selected mode of 
instrument operation.

A rotary knob and 21 hard keys are located to the right of the measurement display. Nine of 
the hard keys are dual purpose, depending upon the current mode of operation. The 
dual-purpose keys are labeled with a number on the key itself. The alternate function is 
printed on the panel above each of these nine keys. Use the shift key to access the functions 
that are printed on the panel. The Escape key (which is used for aborting data entry) is the 
round button located above the submenu keys. The rotary knob, the four arrow keys, and the 
keypad can be used to change the value of an active parameter. The rotary knob can also be 
pressed to duplicate the action of the Enter key.

Arranged in a vertical column on the instrument case and along the right edge of the 
measurement display are 8 submenu keys. They change function depending upon the current 
menu selection. The current submenu key function is indicated in the active function block 
(submenu key labels) on the right edge and within the measurement display. An example of 
the keys is shown in Figure 2-2. 

Figure 2-2. Front Panel Overview
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Other features on the front panel include:

Battery Charge LED (Green)

The Battery Charge LED flashes if the battery is charging, and remains on steady when the 
battery is fully charged. 

Charge Fault LED (Red)

The Charge Fault LED remains on under a battery charger fault condition. Fault conditions 
include a battery cell voltage that is too low to charge or a battery temperature that is outside 
the temperature range (–5 ºC to +45 ºC) for charging.

Fan Inlet and Exhaust Ports

Keeping the fan inlet and exhaust ports clear of obstructions at all times is important for 
proper ventilation and cooling of the instrument.

2-4 Front Panel Keys   
The term hard key refers to all of the buttons on the instrument face except for the vertical 
row of 8 gray buttons adjacent to the right edge of the measurement display screen (the 
8 submenu keys) and the horizontal row of 5 gray buttons below the measurement display 
screen (the 5 main menu keys). 

The hard keys perform as follows:

Esc Key

Press this key to cancel any setting that is currently being made.

Enter Key

Press this key to finalize data input. Pressing the rotary knob performs this same function.

Arrow Keys

The four arrow keys (between the rotary knob and the Esc key) are used to scroll up, down, 
left, or right. The arrow keys can often be used (depending upon measurement selection) to 
change a value or to change a selection from a list. This function is similar to the function of 
the rotary knob. In some measurements, the Left/Right arrow keys change values by different 
increments than the Up/Down arrow keys or the rotary knob. The arrow keys are also used to 
move markers.

Shift Key

Press the Shift key and then press a number key to open the menu that is indicated in blue 
text above the number key. When the Shift key is active, its icon is displayed at the top-right 
of the measurement display area between the battery charge indicator and the submenu 
label. 

The Shift key is also used for UPPERCASE letters when entering text (refer to “Text Entry” 
on page 2-9.

Figure 2-3. Shift Key Icon
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Back Key

Press this key to delete only one character, one number, or the range that is specified by the 
cursor.

+/– Key

Press this key to change the sign of numbers that are entered with the number keys.

Number Keypad

Press these keys to directly input numbers. Number keys 1 through 9 are also used to open 
menus. Refer to the functions of the “Shift Key”.

Rotary Knob

Turn the rotary knob to change numerical values, to scroll through selectable items within a 
list, and to move markers. Values or items may be within a dialog box or an edit window.

Press the rotary knob to finalize the input function in the same manner as pressing the Enter 
key.

Main Menu Keys 

The 5 main menu keys are horizontally arranged adjacent to the measurement display screen 
and along its lower edge. These keys (buttons) have no printed labels. They are positioned to 
accompany virtual key labels that are displayed in the measurement display area. These 
main menu key labels change to match specific instrument Mode settings. Each Mode has a 
specific set of main menu keys. For details about the main menu keys, refer to the section 
“Firmware Overview” on page 2-17. For details about the Mode settings, refer to section 
“Mode Selector Menu” on page 2-6.

Submenu Keys 

These 8 gray keys (buttons) have no printed labels. They are arranged adjacent to the 
measurement display screen along the right-hand edge. They are positioned to accompany 
virtual submenu key labels that are displayed to match instrument modes and measurement 
functions. The submenu label area is also called the Active Function Block (refer to Figure 2-2 
on page 2-3). The virtual key labels change as instrument measurement settings change.
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2-5 Mode Selector Menu  
To access the functions under the Mode menu, select the Shift key, then the Mode (9) key. 
Use the directional arrow keys or the rotary knob to highlight the selection, and press the 
Enter key to select. The list of modes that appears in this menu will vary depending upon the 
options that are installed and activated in your instrument. Figure 2-4 is an example of the 
Mode menu. Your instrument may not show the same list. 

Figure 2-4. Mode Selector Menu
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2-6 Secondary Function Menus 
Pressing the Shift key and then a number key selects the menu function that is printed in 
blue characters above the number key (Figure 2-5). 

Not all Secondary Function Menus are active in various operation Modes. If any one of these 
9 menus is available in a specific instrument Mode of operation, then it can be called from the 
number keypad. It may also be available from a main menu key or a submenu key. The 
Secondary Function Menus are: Preset (1), Calibrate (2), Sweep (3), Measure (4), Trace (5), 
Limit (6), File (7), System (8), and Mode (9).

Figure 2-5. Keypad and Secondary Function Menus
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2-7 Display Overview
Typical measurement displays are shown for the basic Spectrum Analyzer mode of the 
MS272xC. Note that the images shown in this manual may be different from any images that 
are displayed on your Spectrum Master.

Spectrum Analyzer Mode        

Figure 2-6 illustrates some of the key information areas of the MS272xC display. For more 
detailed key descriptions of the Spectrum Analyzer mode, refer to the Spectrum Analyzer 
Measurement Guide (Anritsu part number 10580-00244, available on the Documentation disc 
or the Anritsu web site). Also refer to Appendix A, “Measurement Guides”, for a complete list 
of measurement guides. 

Figure 2-6. Spectrum Analyzer Display
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2-8 Parameter Setting
Pop-up list boxes or edit boxes are used to provide selection lists and selection editors. Scroll 
through a list of items or parameters with the arrow keys or the rotary knob. Select 
numerical values by scrolling with the arrow keys or rotary knob or by entering the digits 
directly from the number keypad. These list boxes and edit boxes frequently display a range 
of possible values or limits for possible values.

Finalize the input by pressing the rotary knob or the Enter key. At any time before finalizing 
the input, press the escape (Esc) key to abort the change and retain the previously existing 
setting.

Some parameters (such as for antennas or couplers) can be added to list boxes by creating 
them and importing them through the use of Master Software Tools.

2-9 Text Entry  
When entering text (as when saving a measurement) the submenu key for Text Entry 
displays the characters (alphabet, hyphen, and underscore) in 6 letters per key (Refer to 
Figure 2-9). Characters can be entered by using the rotary knob or by using the submenu 
keys. Refer to Figure 2-7, Figure 2-8 and Figure 2-9.

The rotary knob scrolls through the characters in a pop-up window and is pressed to select 
each character in sequence.

Alternatively, press the a b c / d e f submenu key (for example) to open another submenu with 
a separate key for each of these letters. The menu returns to the complete character set after 
each individual letter is entered. 

Use the arrow keys to navigate within a name or character string. Use the Shift key for 
capital letters. Press the Enter key or the rotary knob to finalize a text entry.
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Figure 2-7. Text Entry Menu – Lower Case

Figure 2-8. Text Entry Menu – Upper Case

Lowercase Text Entry

Uppercase Text Entry
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Figure 2-9. Text Entry Menu – Selecting Characters

Rotary Knob has scrolled to letter “c”
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2-10 Connector Care 
Visually inspect connectors for general wear, for cleanliness, and for damage such as bent 
pins or connector rings. Repair or replace damaged connectors immediately. Dirty connectors 
can limit the accuracy of your measurements. Damaged connectors can damage the 
instrument. Connection of cables carrying an electrostatic potential, excess power, or excess 
voltage can damage the connector or the instrument or both. Connection of cables with 
inadequate torque settings can affect measurement accuracy. Over torquing connectors can 
damage the cable, the connector, the instrument, or all of these items.

Connecting Procedure 

1. Carefully align the connectors.

The male connector center pin must slip concentrically into the contact fingers of the 
female connector.

2. Push connectors straight together. Do not twist or screw them together.

3. To tighten, turn the connector nut, not the connector body. Major damage can occur to 
the center conductor and to the outer conductor if the connector body is twisted.

4. If you use a torque wrench, then initially tighten by hand so that approximately 1/8 turn 
or 45 degrees of rotation remains for the final tightening with the torque wrench.

Relieve any side pressure on the connection (such as from long or heavy cables) in order 
to assure consistent torque.  Use an open-end wrench to keep the connector body from 
turning while tightening with the torque wrench.

Do not over torque the connector.

Disconnecting Procedure 

1. If a wrench is needed, then use an open-end wrench to keep the connector body from 
turning while loosening with a second wrench.

2. Complete the disconnection by hand, turning only the connector nut.

3. Pull the connectors straight apart without twisting or bending.
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2-11 Test Panel Connectors     
The test panel connector is shown in Figure 2-10 and are described in the following text. 

External Power 

The external power connector is used to power the unit and for battery charging. Input is 
12 VDC to 15 VDC at up to 5.0 A. A green flashing indicator light near the power switch 
shows that the instrument battery is being charged by the external charging unit. The 
indicator is steadily illuminated when the battery is fully charged. 

LAN Connection 

The RJ-45 connector is used to connect the Spectrum Master to a local area network. 
Integrated into this connector are two LEDs. The amber LED shows the presence of a 
10 Mbit/s LAN connection when on, and a 100 Mbit/s LAN connection when off. The green 
LED flashes to show that LAN traffic is present. For additional information about the LAN 
connection, Ethernet connection, and DHCP, refer to Appendix C, “Ethernet Configuration”.

Figure 2-10. Test Panel Connectors for MS272xC

Warning

When using the AC-DC Adapter, always use a three-wire power cable that is 
connected to a three-wire power line outlet. If power is supplied without grounding 
the equipment in this manner, then the user is at risk of receiving a severe or fatal 
electric shock.

External
PowerUSB Interface

Mini-B
USB 
Interface
Type-A

Headset
Jack

Fan Exhaust Port

External
Trigger In

External 
Reference 
In

Reference Out

Option 89
IF Out

RF In

Option 31 
GPS Antenna 
Connector

LAN
Connection



Test Panel Connectors

2-14 PN: 10580-00277  Rev. E Spectrum Master UG

USB Interface – Type A 

The MS272xC Spectrum Master can also be a USB Host and allow various USB Flash 
Memory devices to be connected to the instrument for storing measurements, setups, and 
files.

USB Interface – Type Mini-B  

The USB 2.0 interface can be used to connect the MS272xC Spectrum Master directly to a PC. 
The first time the MS272xC is connected to a PC, the normal USB device detection by the 
computer operating system will take place. The CD-ROM that shipped with the instrument 
contains a driver for Windows XP that is installed when Master Software Tools is installed. 
Drivers are not available for earlier versions of the Windows operating system. During the 
driver installation process, place the CD-ROM in the computer drive and specify that the 
installation wizard should search the CD-ROM for the driver. 

Headset Jack  

The headset jack provides audio output from the built-in AM/FM/SSB demodulator for testing 
and troubleshooting wireless communication systems. The jack accepts a 2.5 mm 3-wire 
miniature phone plug such as those commonly used with cellular telephones.

Ref Out

The External Reference Out port is a BNC female connector that provides 10 MHz at 
approximately –7 dBm to 0 dBm.

To prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC 
connector. Do not overtighten the connector.

Ext Ref In  

The External Reference In port is a BNC female connector that provides for input of an 
external frequency reference. 

To prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC 
connector. Do not overtighten the connector.

IF Out 140 MHz (Option 89) 

BNC connector for Zero Span 140 MHz IF Output with Option 89.

To prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC 
connector. Do not overtighten the connector.

Ext Trigger In  

A TTL signal that is applied to the External Trigger female BNC input connector causes a single 
sweep to occur. In the Spectrum Analyzer mode, it is used in zero span, and triggering occurs 
on the rising edge of the signal. After the sweep is complete, the resultant trace is displayed 
until the next trigger signal arrives.

To prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC 
connector. Do not overtighten the connector.

Note
For proper detection, Master Software Tools should be installed on the PC prior to 
connecting the Spectrum Master to the USB port.
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RF In  

50 Ω Type-N connector (MS2722C, MS2723C, MS2724C) or a 50 Ω Type-K male ruggedized 
connector (MS2725C, MS2726C).

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connector. Do not overtighten the connector. The recommended torque is 12 lbf·in to 
15 lbf·in (1.36 N·m to 1.70 N·m).

GPS Antenna Connector (Option 31)   

The GPS antenna connection on the Spectrum Master is type SMA(F). Selectable +3 VDC or 
+5 VDC antenna power.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
SMA connector. Do not overtighten the connector. The recommended torque is 8 lbf·in 
(0.9 N·m or 90 N·cm).

2-12 Symbols and Indicators
The following symbols and indicators convey the instrument status or condition on the 
display. 

Cal Status On: 

The Spectrum Master has been calibrated with discrete Open, Short, and Load components.

Cal Status Off:

The Spectrum Master has not been calibrated.

Battery Symbol: 

The battery symbol above the display indicates the charge remaining in the battery. 
The colored section inside the symbol changes size and color with the charge level. 

Green: Battery is 30% to 100% charged

Yellow: Battery is 10% to 30% charged

Red: Battery 0% to 10% charged

Lightning Bolt: Battery is being charged (any color symbol)

When the battery is charging, either from the AC-DC Adapter or the 12 Volt DC adapter, the 
symbol changes to that shown in Figure 2-12: 

Figure 2-11. Battery Status

Figure 2-12. Battery Charging Status
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The Battery Charge LED (refer to Figure 2-2 on page 2-3) flashes when the battery is 
charging, and remains on steady when the battery is fully charged. 

The battery symbol is replaced by a red plug body to indicate that the instrument is running 
from external power and is not charging the battery (or to indicate that the battery is not 
present). When the external AC adaptor is connected, the battery automatically receives a 
charge, and the battery symbol with the lightning bolt is displayed (Figure 2-12). When the 
battery is not installed, the red plug body is displayed, as shown in Figure 2-13, and the red 
Fault LED will be on. If the battery is installed but has lost communications with the 
instrument, then the battery charge indicator will not be shown. 

Hold 

The Spectrum Master is on hold. To resume sweeping, toggle from Hold to Run in the Sweep 
menu.

Single Sweep

Single Sweep is selected. Press Continuous sweep to resume sweeping.

Caution Use only Anritsu-approved batteries, adapters, and chargers with this instrument.

Figure 2-13. Battery Not Installed
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2-13 Firmware Overview

Main Menu Keys 

The Spectrum Master menu-driven interface is easy to use and requires little training. The 
5 Main Menu keys are located below the measurement display. These 5 keys are used to list 
function-specific menus in the active menu (submenu labels). These Main Menu keys vary in 
function based on the selected mode of operation (Shift, Mode (9)). Refer to 
“Mode Selector Menu” on page 2-6 for more information on changing the instrument mode. 
Table 2-1 lists from left to right the Main Menu Key labels for each mode of instrument 
operation. 

Submenu Keys

The 8 submenu keys are located to the right of the measurement display. They change 
function depending upon the current mode and current menu selection. The current submenu 
title is shown at the top of the active function block (submenu keys labels). Refer to Figure 2-2 
on page 2-3.

Table 2-1. Mode-Dependent Main Menu Keys Located Below Measurement Display 

Mode Key 1 Key 2 Key 3 Key 4 Key 5

Spectrum Analyzer Freq Amplitude Span BW Marker

Interference 
Analysis

Freq Amplitude BW Measurements Marker

Channel Scanner Scanner Amplitude Custom Scan Measurements

Power Meter Freq Amplitude Average Limits

High Accuracy 
Power Meter

Amplitude Average Zero/Cal Limit

GSM/GPRS/EDGE Freq Amplitude Setup Measurements Marker

W-CDMA/HSDPA Freq Amplitude Setup Measurements Marker

TD-SCDMA/HSDPA Freq Amplitude Setup Measurements

CDMA Freq Amplitude Setup Measurements Marker

EV-DO Freq Amplitude Setup Measurements Marker

LTE Freq Amplitude Setup Measurements Marker

Fixed WiMAX Freq Amplitude Setup Measurements

Mobile WiMAX Freq Amplitude Setup Measurements Marker

DVB-T/H Frequency Amplitude Setup Measurements Marker

AM/FM/PM Analyzer Freq Amplitude Setup Measurements Marker
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Chapter 3 — Quick Start Guide

3-1 Introduction
This chapter provides a brief overview of the Anritsu MS272xC Spectrum Master. The intent 
of this chapter is to provide a starting point for making basic measurement setups. This 
chapter describes setup, configure frequency, bandwidth, and amplitude before configuring 
your measurement setups. After measurements are taken, refer to section “Managing Files” 
on page 4-1 for a description of saving, recalling, and deleting measurement files. For more 
detailed information about specific measurements, refer to the measurement descriptions in 
the measurement guides for the specific instrument mode and analyzer technology (such as 
Spectrum Analyzer, WiMAX, or 3GPP). Refer to Appendix A, “Measurement Guides”, for a 
list of these measurement guides and their Anritsu part numbers.

The Spectrum Analyzer Measurement Guide includes sections that describe resolution 
bandwidth, video bandwidth, sweep, and attenuator functions. For example, in the 
Spectrum Master, Resolution Bandwidth is determined by the intermediate frequency (IF) 
filter bandwidth. The spectrum analyzer traces the shape of the IF filter as it tunes past a 
signal. If more than one IF filter is used in a spectrum analyzer, then the narrowest one 
dominates and is considered the resolution bandwidth. Figure 3-1 is an example of a 
spectrogram display. 

Figure 3-1. Spectrogram Example
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3-2 Measurement Setup

Connect the Input Source

Connect the input signal or antenna to the appropriate test connector on the top of the 
instrument. For connector descriptions, refer to Figure 2-10 on page 2-13.

Editing and Entering Values

• Parameter values that are ready for editing are displayed in red on the submenu key. 
After changing the value, press Enter to set the new value.

• Some submenu keys have toggled parameter values (On / Off, Low / High). On these 
submenu keys, the current value is underlined. Press the submenu key to toggle the 
value.

• Use the arrow keys, numeric keypad, or rotary knob to change submenu key values, 
to select list box options, or to enter filenames.

Selecting the Analyzer Mode 

1. Press the Shift key followed by pressing the Mode (9) key on the numeric keypad to open 
the Mode Selector list box (refer to section “Mode Selector Menu” on page 2-6).

2. Use the directional arrow keys or the rotary knob to highlight the desired mode, and 
press the Enter key or the rotary knob to select.
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3-3 Set the Measurement Frequency  

Using Start and Stop Frequencies 

1. Press the Freq main menu key.

2. Press the Start Freq submenu key.

3. Enter the desired start frequency. When entering a frequency by using the keypad, the 
submenu key labels change to frequency units: GHz, MHz, kHz, and Hz. Press the 
appropriate unit key. Pressing the Enter key has the same affect as pressing the MHz 
submenu key.

4. Press the Stop Freq submenu key.

5. Enter the desired stop frequency.

Entering Center Frequency 

1. Press the Freq main menu key.

2. Press the Center Freq submenu key.

3. Enter the desired center frequency by using the keypad, the arrow keys, or the rotary 
knob. When entering a frequency by using the keypad, the submenu key labels change 
to frequency units: GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing 
the Enter key has the same affect as pressing the MHz submenu key.

The current setting is shown at the top of the instrument settings summary column on the 
left side of the measurement display (refer to Figure 2-6, “Spectrum Analyzer Display” 
on page 2-8).

Selecting Signal Standard   

1. Press the Freq main menu key.

2. Press the Signal Standard submenu key. The Signal Standards dialog opens.

3. Highlight a signal standard and press Enter or the rotary knob to select.

4. Press the Channel submenu key to change the channel value in the Channel Editor. 

Setting Measurement Frequency Bandwidth   

Spectrum Analyzer and Interference Analysis Mode

1. Press the BW main menu key to display the BW menu.

• Press the RBW or the VBW submenu key (or both) to manually change values.

• Set RBW and VBW automatically by pressing the Auto RBW submenu key or the 
Auto VBW submenu key.

2. Press the VBW/Average Type submenu key to toggle between Linear averaging 
(arithmetic mean) and Logarithmic averaging (geometric mean).

3. Press the RBW/VBW submenu key to change the ratio of resolution bandwidth to video 
bandwidth.

Note The signal standards list can be updated via Master Software Tools.
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4. Press the Span/RBW submenu key to change the ratio of span width to resolution 
bandwidth.
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3-4 Set the Amplitude  
Press the Amplitude main menu key to display the Amplitude menu.

Setting Amplitude Reference Level and Scale

Spectrum Analyzer and Interference Analysis Modes 

1. Press the Reference Level submenu key and use the Up/Down arrow keys or the keypad 
to change the reference level. Press Enter to set the reference level value. 

2. Press the Scale submenu key and use the Up/Down arrow keys or the keypad to enter 
the desired scale. Press Enter to set the scale value.  

Setting Amplitude Range and Scale 

1. Press the Adjust Range submenu key to set an optimal reference level based on the 
measured signal. 

2. Press the Scale submenu key.

3. Enter the desired scale units by using the keypad, the arrow keys, or the rotary knob. 
Press the Enter key to set. The y-axis scale is automatically renumbered.

Note
To change the current measurement units, press the Units submenu key and 
select the required units from the submenu keys that are presented. Press the 
Back submenu key to return to the Amplitude menu.

Note

The Scale parameter cannot be changed when linear units are selected (Watts or 
Volts). Press the Amplitude submenu key and select Auto Atten coupling of the 
attenuator setting and the reference level to help ensure that harmonics and spurs 
are not introduced into the measurements. Attenuator Functions are described in 
the Spectrum Analyzer Measurement Guide.

Note

This setting applies to most demodulator modes of instrument operation. The 
Spectrum Analyzer mode has no equivalent to Auto Range. For other analyzer 
modes, consult the individual measurement guides. Refer to 
Appendix A, “Measurement Guides”.

Note
To have the instrument continually set the optimal reference level, press the 
Auto Range submenu key so that On is selected.
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Reference Level Offset for External Loss or External Gain

To obtain accurate measurements, compensate for any external attenuation or gain by using 
the RL Offset submenu. The compensation factor is in dB. External attenuation can be 
created by using an external cable or an external high power attenuator, external gain is 
typically from an amplifier.  

To adjust the reference level for either gain or loss, press the RL Offset submenu key and 
enter a positive dB value and then press the appropriate submenu key (dB External Gain or 
dB External Loss). The new RL Offset value will be displayed on the instrument and reference 
level is adjusted.

3-5 Set the Span  
Spectrum Analyzer, Interference Analysis, and Power Meter Modes

1. Press the Span main menu key or press the Freq main menu key followed by the Span 
submenu key.

2. To select full span, press the Full Span submenu key. Selecting full span overrides any 
previously set Start and Stop frequencies.

3. For a single frequency measurement, press the Zero Span submenu key. 

Note
To quickly move the span value up or down, press the Span Up 1-2-5 or 
Span Down 1-2-5 submenu keys These keys facilitate a zoom-in, zoom-out 
feature in a 1-2-5 sequence. 
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3-6  Setting Up Limit Lines  
Press the Shift key then the Limit (6) key on the numeric keypad to display the Limit menu.

Simple Limit Line

Spectrum Analyzer and Interference Analysis Modes

1. Press the Shift key and then the Limit (6) key. 

2. Press the Limit (Upper / Lower) submenu key to select the desired limit line, Upper or 
Lower.

3. Activate the selected limit line by pressing the On Off submenu key so that On is 
underlined.

4. Press the Limit Move submenu key to display the Limit Move menu. Press the Move Limit 
submenu key to change the dBm level of the limit line.

5. Press the Back submenu key to return to the Limit menu.

6. If necessary, press the Set Default Limit submenu key to redraw the limit line in view.

Limit Line Envelope

Spectrum Analyzer and Interference Analysis Modes 

Using Limit Envelope:

1. Press the Shift key and then the Limit (6) key. 

2. Press the Limit (Upper / Lower) submenu key to select the desired limit line, Upper or 
Lower.

3. Press the Limit Envelope submenu key to display the Limit Envelope menu.

4. Press the Create Envelope submenu key to create an envelope around the measurement.

5. Press Upper Points or Lower Points submenu key to change the number of segments in 
the envelope.

6. Press the Upper Shape or Lower Shape submenu key to toggle between square and 
sloped limit envelope.

7. Adjust the Upper or Lower Offset to move the limit line closer to (a smaller value) or 
further away from the trace.



Setting Up Limit Lines

3-8 PN: 10580-00277  Rev. E Spectrum Master UG

Complex Limit Lines

Spectrum Analyzer and Interference Analysis Modes

Figure 3-2 shows an example of a complex limit line. After the right half of the limit line was 
completed, the left half of the limit line was built by pressing the Limit Advanced submenu key 
and then pressing the Limit Mirror submenu key.   

 

Figure 3-2. Complex Limit Line Example
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3-7 Setting Up Markers  
Press the Marker main menu key to display the Marker menu. Refer to Figure 3-3.

Selecting, Activating, and Placing a Marker

1. Press the Marker 1 2 3 4 5 6 submenu key so that the desired marker number is 
underlined. Each press of the Marker 1 2 3 4 5 6 submenu key toggles to the next higher 
number (cycling from 6 back to 1 again). Press Shift, then the Marker 1 2 3 4 5 6 
submenu key to cycle backward through the marker list.

2. Press the On Off submenu key so that On is underlined. The selected marker is 
displayed in red, ready to be moved.

3. Use the rotary knob to place the marker on the desired frequency.

4. Repeat Step 1 and Step 2 to activate and move multiple markers.

Selecting, Activating, and Placing a Delta Marker:

1. Press the Marker 1 2 3 4 5 6 submenu key so that the desired delta marker number is 
underlined.

2. Press the Delta On Off submenu key so that On is underlined. The selected marker is 
displayed in red, ready to be moved.

3. Use the rotary knob or the numeric keypad to place the delta marker on the desired 
offset frequency from the associated reference marker.

4. Repeat Step 1 and Step 2 to activate and move multiple markers.

Viewing Marker Data in a Table Format

1. Press the More submenu key.
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2. Press the Marker Table On Off submenu key so that On is underlined. All markers and 
delta marker data are displayed in a table under the measurement graph.

3-8 Selecting a Measurement Type
1. Change the measurement mode (if required). Press Shift then Mode (#9).

2. Select the measurement type. Press Shift then Measure (#4). Select the appropriate 
measurement type with the submenu key.

3-9 Saving Measurements
1. Press Shift then File (#7).

2. Press the Save Measurement submenu key.

3. Press the Change Save Location submenu key and set the current location to be the USB 
flash drive or internal memory, and then press Set Location.

4. Press Change Type (Setup/JPG/…) and select Measurement.

5. Enter the file name using the letter key and press Enter.

Refer to Chapter 4, “File Management” for additional information.

3-10 Master Software Tools
Anritsu Master Software Tools is a Microsoft Windows compatible program for transferring 
and editing saved measurements, markers, and limit lines to a PC. Refer to 
Chapter 7, “Master Software Tools” for an overview of MST.

Figure 3-3. Six Noise Markers
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Chapter 4 — File Management

4-1 Introduction
This chapter will review the file management features of the Spectrum Master and detail the 
File menu. The submenus under this menu allow the user to save, recall, copy, and delete files 
in internal memory or an external USB flash drive.

4-2 Managing Files
Press the Shift key then the File (7) key on the numeric keypad to list the File menu. Follow 
the additional steps below.

Save Files

Set the Save Location 

Press Save then the Change Save Location submenu keys and select the location to save files. 
You can save files to the internal memory or to an external USB flash drive. You can also 
create new folders. If an external USB flash drive is connected or disconnected, press Refresh 
Directories to update the location tree. Press the Set Location key to store the save location.

Save Measurement As

The Save Measurement As key is used to quickly save measurements with a specific file 
name. The Spectrum Master saves the measurement with the latest file name that was used 
to save a measurement and with a number that is automatically incremented and appended 
to the end of the file name. For instance, if the last measurement was saved with the name 
Site 1 Trace, Save Measurement As saves the next measurement as Site 1 Trace_#1, Site 1 
Trace_#2, etc. The file name used can be changed using the “Save Menu” on page 4-8.

Save a Measurement

Press the Save Measurement key and enter the name for the measurement file. The file type 
will default to measurement and the appropriate extension will be added based on the current 
measurement mode. 

Save a Setup 

Press the Save submenu key, type a name for the setup file, confirm that the file type is Setup 
using the Change Type key and press Enter to save. 

Save a Measurement Screen as JPEG 

Press the Save submenu key, type a name for the JPEG file, confirm that the file type is Jpeg 
using the  Change Type key and press Enter to save.

Note
When navigating through the File menu, pressing the Esc key will return to the 
previous menu.
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Recall Files

The recall menu enables you to view all the Measurement and Setup files in the internal 
memory and external USB flash drive.

You can sort the recall menu by name, date, or type. You can also select to view only 
measurement files or setup files by pressing File Type on the Recall dialog box and selecting 
the file type you want to view.

Recall a Measurement

From the File menu, press the Recall Measurement submenu key, select the measurement 
with the rotary knob or the Up/Down arrow keys and press Enter. 

Recall a Setup

Press the Recall submenu key. Confirm that the file type is Setup or All using the File Type 
key. Select the setup file (.stp) with the rotary knob or the Up/Down arrow keys and press 
Enter.

Recall Dialog Box 

The Recall dialog box (Figure 4-1) will open previously saved measurements and setups. 
See the “Recall Menu” on page 4-11 for additional information. 

Figure 4-1. Recall Dialog Box
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Copying Files 

The steps below detail copying a file from internal memory to an external flash drive. Select 
the files to copy in the top window and the location for the files to be copied to in the bottom 
window (Figure 4-2). Refer to the “Copy Menu” on page 4-12 for additional information.

1. Insert a USB drive into either USB Type A port of the Spectrum Master. 

2. From the File main menu, press the Copy submenu key. The Copy submenu and Copy 
dialog box are displayed.

3. Select the file(s) to copy. To select multiple files, highlight the first then press the Select 
or De-Select key to keep the file selected. The file will be outlined in blue (Figure 4-2). 
Repeat with all the files to copy. 

Figure 4-2. Two .jpg Files Ready to Copy from Internal Memory to the USB Drive, Jpeg Folder  

Note Use the Left/Right arrow keys to Collapse/Expand folders.
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4. To display files within a folder, select the folder and press the Enter key or the 
Right arrow key. The + symbol indicates additional files or folders with the folder 
(Figure 4-3). To expand the + symbol, highlight the folder and press the Right arrow 
key.  

5. Press the Scroll key and highlight the USB drive in the lower window using the 
Up/Down arrow keys. The Scroll submenu key toggles between Src (top window) and 
Dst (bottom window). 

6. Select the copy location on the USB drive.

7. Press the Copy key to copy the files to the USB drive.

Figure 4-3. Expanded Folder
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Deleting Files 

Delete a Selected File or Files 

Press the Delete submenu key. Highlight the file to be deleted with the Up/Down arrow keys. 
Press the Select or De-Select key. The file will be highlighted in blue when selected. Press the 
Delete key and Enter to delete the selected file. 

Delete Dialog Box

Press the Delete submenu key to open the Delete dialog box (Figure 4-4). The submenus allow 
sorting by file type, name and saved date. See the “Delete Menu” on page 4-13 for additional 
information. 

Figure 4-4. Delete Dialog Box
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4-3 File Menu Overview
Open this menu by pressing the Shift key, then the File (7) key. 

Figure 4-5. File Menu
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4-4 File Menu 
Key Sequence: File

Save Measurement As: This key will save the current setup with a user 
defined file name. The default file name is changed using the Save submenu. 
To change the default file name, press the Save Measurement submenu key 
to open the Save dialog box. Enter the new measurement filename with the 
letter keys. Refer to “Save Menu” on page 4-8. Press Enter to save the name 
and return to the File menu. The Save Measurement As submenu key 
displays the new entered name appended with _#1.spa. After a few seconds 
the screen with return to File menu. Press the Save Measurement As key 
again and the new file name will be used. Measurement files names have a 
.spa extension. 

Save Measurement: Press this submenu key to display the “Save Menu” 
on page 4-8 and Save dialog box. Measurements can be saved to internal 
memory or to a USB flash drive. The saved measurement can be named 
using the text entry keys. By default, measurements are saved in a directory 
named /user to internal memory. The save destination is set with the 
“Save Location Menu” on page 4-9.

Save: Press this submenu key to display the “Save Menu” on page 4-8. 
Measurements can be saved to internal memory or to a USB flash drive. 
The saved setup, measurement or JPEG file can be named by using the text 
entry keys. By default, measurements are saved in a directory named /user to 
internal memory. The save destination is set with the “Save Location Menu” 
on page 4-9.

Save on Event (Spectrum Analyzer mode only): Press this submenu key to 
display the “Save On Event Menu” on page 4-10. 

Recall Measurement: Press this submenu key to display the “Recall Menu” 
on page 4-11. This menu is for recalling measurements from internal memory 
or a USB flash drive.

Recall: Press this submenu key to display the “Recall Menu” on page 4-11. 
This menu is for recalling measurement or setup data from internal memory or 
a USB flash drive.

Copy: Press this submenu key to display the “Copy Menu” on page 4-12. 
This submenu is for copying files or folders from internal memory or a USB 
flash drive.

Delete: Press this submenu key to display the “Delete Menu” on page 4-13 
and a selection box that shows the setup and measurement names, the type 
and the date and time that the information was saved. Use the rotary knob or 
the Up/Down arrow keys to highlight the file that is to be deleted and press 
the Delete submenu key, then Enter. Press the Esc key to cancel the 
operation. Note that deleted files can not be recovered.

Figure 4-6. File Menu
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Save Menu 

Key Sequence: File > Save 

Text Entry Keys: The top 5 keys are for text entry. The submenu keys for 
Text Entry displays the characters (alphabet, hyphen, and underscore). Press 
the a b c / d e f submenu key (for example) to open another submenu with a 
separate key for each of these letters. Characters can be entered by using the 
rotary knob or by using the submenu keys. 

The rotary knob scrolls through the characters in a pop-up window and 
pressing the rotary knob enters a character. The menu returns to the complete 
character set after each individual letter is entered. 

Use the arrow keys to navigate within a name or character string. Use the 
Shift key for capital letters. Press the Enter key or the rotary knob to finalize a 
text entry.

Back Space:  Use this key to delete a file name highlighted in blue or delete 
individual characters.

Change Save Location: Press this submenu key to open the “Save Location 
Menu”. 

Change Type: Press this submenu key to select what type of file is saved. 
The options are the Measurement, Setup, or Jpeg. The file type can be 
changed with the Up/Down keys or the rotary knob.

Setup (.stp): Setup files contain basic instrument information, 
measurement mode setup details, measurement marker data, and limit 
data.

Measurement (.spa): Contains the measurement data and opens  with 
Master Software Tools.

Jpeg (.jpg): Jpeg files contain a screen capture of the display.

Limit Lines (.lim): The Limit line file contains limit line data details.

Figure 4-7. Save Menu
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Save Location Menu 

Key Sequence: File > Save > Change Save Location 

This menu and dialog box is used to create folders and select where the 
Spectrum Master will save the current file. Select folders or drives with the 
Up/Down keys or the rotary knob. 

Note: Only folders (not files) are visible in the Save Location dialog box. To 
view files, use the “Recall Menu” on page 4-11.

Sort By: Press this submenu key to sort the folders by Name, Type, or Date. 

Sort Order: Displays the folder names in ascending or descending order.

Create Folder: This key will create a new folder in the highlighted location or 
folder. The create directory dialog box will display for naming the folder.

Set Location: This key will set the current location for saving files and return 
to the “Save Menu” on page 4-8.

Refresh Directories: Press this key to update the display.

Figure 4-8. Save Location Menu

Figure 4-9. Select Save Location Dialog Box
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Save On Event Menu 

Key Sequence: File > Save On Event 

This menu is used to auto save measurements to internal memory after:

...Crossing Limit: Toggling this submenu key to On will save the 
measurement to internal memory when the measurement has crossed 
a defined limit line created with the Limit menu.

...Sweep Complete: Toggling this submenu key to On will save the 
measurement to internal memory after the current sweep is complete. If 
Save Then Stop is toggled Off, a measurement will be saved after every 
sweep.

Save Then Stop: Set this key to On to stop the sweep after a measurement 
is saved. With this key Off and Sweep Complete On a measurement is 
saved after every sweep.

Clear All: Pressing this key will turn Off the three save on event keys:

Crossing Limit

Sweep Complete

Save Then Stop 

Figure 4-10. Save On Menu
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Recall Menu 

Key Sequence: File > Recall 

This menu and dialog box is used to create folders and select where the 
Spectrum Master will save the current file. Select folders or drives with the 
Up/Down keys or the rotary knob. 

Sort By: Press this submenu key to sort file and folders by the 
file name, by the type of file, or by the date that the file or folder was 
saved.

Sort Order: Displays the folder or file in ascending or descending order 
based on the selection in the Sort By key.

File Type: Press this submenu key to select what type of file is viewed. The 
options are the ALL, Measurement, or Setup. The file type can be changed 
with the Up/Down keys or the rotary knob. Press Enter to make the 
selection.

Setup: Setup files contain basic instrument information, 
measurement mode setup details, measurement marker data, and 
limit data. 

Measurement: Measurement files contain all of the information in the 
setup files and the measurement data.

Limit Lines (.lim): The Limit line file contains limit line data details.

ALL: Displays all file types.

Refresh Directories: Press this key to update the display.

Figure 4-11. Recall Menu
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Copy Menu 

Key Sequence: File > Copy 

This menu and dialog box is used to copy folders and files. Select folders or 
files with the Up/Down keys or the rotary knob. Figure 4-2 on page 4-3 
shows the Copy dialog box with two Jpeg images selected and ready to be 
copied to the USB flash drive. Highlight a folder and press Enter or the 
Right arrow key to view the contents.

Sort By: Press this submenu key to sort file and folder lists by name, 
by type of file, or by the date that the file was saved.

Sort Order: Displays the folder or file in ascending or descending order 
based on the selection in the Sort By key.

File Type: Press this submenu key to select what type of file to view for 
copying. The options are: ALL, Measurement, Setup, or Jpeg. The file type 
can be changed with the Up/Down keys or the rotary knob. Press Enter to 
make the selection.

Refresh Directories: Press this key to update the display. 

Scroll: Press this submenu key to use the scroll function in the Source 
Window (Scr - top panel) or Destination Window (Dst - bottom panel). See 
Figure 4-2.

Note: Previously saved files are not visible in this window.

Select or De-Select: Use this key to select or deselect the file(s) or 
folder(s) to be copied. When selected, a file or folder will be outlined in blue, 
see Figure 4-2. 

Copy: Copies the files or folders selected in the top window to the 
destination selected in the bottom window. A dialog box will display showing 
when the copying is complete. If a file with the same name exists in the 
destination folder a warning box will display to allow file overwrite or to 
cancel.

Figure 4-12. Copy Menu
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Delete Menu

Key Sequence: File > Delete 

This menu and dialog box is used to delete folders and files. Select folders or 
files with the Up/Down keys or the rotary knob. 

Sort By: Press this submenu key to sort files and folders by name, by 
the type of file, or by the date that the file or folder was saved.

Sort: Displays the folder or file in ascending or descending order based on 
the selection in the Sort By key.

File Type: Press this submenu key to select what type of file view for 
deleting. The options are the ALL, Measurement, Setup, Limit Lines, 
or Jpeg. The file type can be changed with the Up/Down keys or the rotary 
knob. Press Enter to make the selection.

Select or De-Select: Use this key to select or deselect the file(s) or 
folder(s) to be deleted. When selected, a file or folder will be outlined in blue.

Delete: Press this key to open the Delete dialog box. Press Enter to delete 
the selected item or Esc to Cancel. 

Refresh Directories: Press this key to update the display.

Figure 4-13. Delete Menu
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Chapter 5 — System Operation

5-1 Introduction
This chapter reviews the Spectrum Master system operations.

The other menus (Sweep, Measure, Trace, and Limit) are described in the Measurement 
Guides that are listed in Appendix A.
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5-2 System Menu Overview   
To access the functions under the System menu, press the Shift key, then the System (8) key. 
Menu maps typically display all possible submenu keys, although some keys are displayed on 
the instruments only under special circumstances (refer to menu descriptions on the following 
pages). 

Figure 5-1. System Menu Map
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5-3 System Menu   
Key Sequence: Shift, System (8) 

Status: Press this submenu key to display the current system status, 
including the operating system and firmware versions, temperatures, and 
other details such as current battery information. Press Esc or Enter to return 
to normal operation.

Self Test: Press this submenu key to run a series of tests that are related to 
the performance of the motherboard hardware. Press the Esc key to abort, or 
press the Enter key to continue. The display lists a summary of those tests 
that have passed. If any test fails, then all of the performed tests are listed 
with Pass/Fail notification. 

If the Self Test fails when the battery is fully charged and the instrument is 
within the specified operating temperature, then contact your Anritsu Service 
Center (refer to “Anritsu Service Centers” on page 1-7) and report the test 
results. Press Esc or Enter to return to normal operation.

Application Self Test: Press this submenu key to run a series of tests that 
are related to the performance of the instrument hardware and that are 
specific to the current instrument application (refer to 
Section 2-5 “Mode Selector Menu” on page 2-6). Press the Esc key to abort, 
or press the Enter key to continue. The display lists a summary of those tests 
that have passed. If any test fails, then all of the performed tests are listed 
with Pass/Fail notification. If any test fails, then contact your Anritsu Service 
Center and report the test results (refer to “Anritsu Service Centers” 
on page 1-7).

GPS: Press this submenu key to open the GSP Menu. Refer to 
Chapter 6, “GPS (Option 31)” for additional information.

Application Options: Submenu keys are specific to each measurement 
mode. Please refer to a specific Measurement Guide, as listed in Appendix A.

System Options: Press this submenu key to open the “System Options 
Menu” on page 5-4.

Figure 5-2. System Menu
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System Options Menu  

Key Sequence: Shift, System (8) > System Options 

Date & Time: Press this submenu key to display a dialog box for setting the 
current date and time. Use the submenu keys or the Left/Right arrow keys to 
select the field to be modified. Use the keypad, the Up/Down arrow keys, or 
the rotary knob to select the date and time. Press Enter to accept the 
changes, or press the Esc key to return to normal operation without changing 
anything.

Ethernet Config: Press this submenu key to display the Ethernet submenu 
and to open the Ethernet Editor dialog box to set the IP address of the 
instrument. For details, refer to section “Ethernet Configuration” on page C-1 
in Appendix C, “LAN and DHCP”.

Language: Press this submenu key to open a list box and select a built-in 
language for the Spectrum Master displays. The languages that are currently 
available are: English, French, German, Spanish, Japanese, Chinese, 
Korean, and Italian. In addition, a custom language may be selected if it has 
been defined by using Master Software Tools and loaded into the 
Spectrum Master. Two custom languages may be loaded into the instrument 
via Master Software Tools. If a mode does not have language translations 
available, then English is the default language. Press Enter to accept the 
change, or press the Esc key to return to normal operation without changes.

In addition, any existing language (except English) may be edited for a better 
local translation.

Note: A Factory Default reset (Esc+On) will overwrite any custom settings 
within the Spectrum Master and will require that you reload the custom 
language files via Master Software Tools.

Display: The Display submenu key opens the “Display Settings Menu” 
on page 5-6 allowing brightness control and the selection of the default color 
display, black & white display, night vision display, or a high contrast display.

Name: Press this submenu key to open a dialog box to name the instrument. 
The Spectrum Master can be named by using the text entry controls as 
described in section “Text Entry” on page 2-9. Press Enter to save the name.

Volume: Press this submenu key to set the speaker volume. The current 
volume setting is displayed on the screen. Use the keypad, the Up/Down 
arrow keys, or the rotary knob to change the volume, and press the Enter key 
to accept the change.

Reset: Press this submenu key to open the “Reset Menu” on page 5-7.

More: Press this submenu key to open the “System Options 2/2 Menu” 
on page 5-5.

Figure 5-3. System Options Menu
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System Options 2/2 Menu    

Key Sequence: Shift, System (8) > System Options > More 

Remote Access Password       

This function is valid only with Master Software Tools (MST) v2.21.1 or later. After setting 
the password, reboot the instrument (normal power OFF then ON) to provide remote access 
security. Only one user then has access at any one time. 

The password is first set into the instrument, then used in MST. When prompted in MST, 
enter the password into the password text box. The password text box shown in Figure 5-5 
may differ from the text box that is displayed on your instrument. 

The password can be removed or reset by a Master Reset, by a Factory Default reset, or by a 
firmware update (which includes a restart).

Share CF & Pwr Offset
All Modes Not Shared: Press this submenu key to toggle the setting to 
All Modes or to Not Shared. Select All Modes to have the current center fre-
quency setting and power offset setting carried over when changing measure-
ment modes. This function is not applicable to measurements that do not 
have a center frequency or power offset setting or to measurements in which 
the current center frequency or power offset setting is outside the range of the 
new measurement.

Set Remote Access Password: Press this submenu key to open the Pass-
word text box (Figure 5-5) and Text Entry menu. Type in the desired pass-
word. Upper case and lower case letters and the symbols - _ + . are the 
allowed password characters. Press Enter to save or Esc to cancel.

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-4. System Options Menu 2/2) 

Warning Do not use SCPI commands with this feature.

Figure 5-5. Remote Access Password Text Box
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Display Settings Menu 

Key Sequence: Shift, System (8) > System Options > Display 

Brightness: The brightness of the display can be adjusted to optimize 
viewing under a wide variety of lighting conditions. Use the keypad, the 
Up/Down arrow keys or the rotary knob to select a brightness level from 
1 to 9, with 9 being the brightest. Press Enter to accept the change.

Default Colors: Sets the display colors to their factory default condition. 
Used for normal viewing.

Black & White: Sets the display colors to black and white. Used for printing 
and viewing in broad daylight conditions.

Night Vision: Sets the display to a red-tinted color. Optimized for night-time 
viewing.

High Contrast: Increases the contrast of the default display colors. Used for 
other challenging viewing conditions.

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-6. Display Settings Menu
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Reset Menu  

Key Sequence: Shift, System (8) > System Options > Reset    

Factory Defaults: Press this submenu key to restore the Spectrum Master to 
its factory default parameter values and Mode settings, including Ethernet, 
language, and brightness settings. Press the Enter key to initiate the reset. 
The Spectrum Master is automatically rebooted as part of this operation. To 
return to normal operation without resetting, press Esc rather than pressing 
Enter.

Note: This same reset sequence can be initiated when turning the 
Spectrum Master On by pressing and holding the Esc+On keys until the 
Anritsu splash screen is displayed.

Master Reset: Press this submenu key to restore the factory setting to all 
system parameters, including Ethernet, language, and brightness settings. 
Also, all user files in the internal memory are deleted, and the original 
language and antenna files are restored. Press the Enter key to initiate the 
reset. The Spectrum Master is automatically rebooted as part of this 
operation. To return to normal operation without resetting, press Esc rather 
than pressing Enter.

Note: This same reset sequence can be initiated when turning the 
Spectrum Master On by pressing and holding the System (8)+On keys until 
the Anritsu splash screen is displayed.

Update Firmware: Press this submenu key to update the instrument 
operating system using an external USB drive. Press Enter to begin the 
update, or press Esc to return to normal operation without updating. Refer to 
“Update Firmware” on page 5-9 for additional information.

Frequency Blanking On/Off (Option 7 Only): The Frequency Blanking 
submenu only displays when Option 7, Secure Data is installed on the 
Spectrum Master. When Frequency Blanking is turned On, all frequency 
values that are displayed on the screen and menu buttons are replaced with 
##.#####. This security measure allows the use of the instrument without 
sensitive frequency information being displayed on the screen. 

Setting Frequency Blanking to Off will preset the instrument settings and 
frequencies to the factory default settings (the current frequency settings will 
not be saved or displayed on the instrument).

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-7. Reset Menu
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5-4 Preset Menu  
Key Sequence: Shift, Preset (1) 

5-5 Power On Self Test  
At power on, the Spectrum Master runs through a series of quick checks to ensure that the 
system is functioning properly. The System self test (refer to “Self Test” on page 5-3) runs a 
series of tests that are related to the instrument. The Application Self Test (refer to 
“Application Self Test” on page 5-3) runs a series of tests that are related to the current 
operating mode of the instrument. 

If the Spectrum Master is within the specified operating range with a charged battery, and if 
the self test fails, then contact your Anritsu Service Center. 

To initiate a self test when the system is already powered up:

1. Press the Shift key and then the System (8) key.

2. Press the Self Test submenu key. The Self Test results are displayed. 

Press the Esc key to continue.

Preset: This key resets the instrument to the default starting conditions.

Save Setup: Opens the Save dialog box to name and save the current 
operating settings, allowing them to be recalled later to return the instrument 
to the state it was in at the time the setup was saved. 

Recall Setup: This key allows the selection and recall of a previously stored 
instrument setup. All current instrument settings are replaced by the stored 
setup information. 

Figure 5-8. Preset Menu
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5-6 Update Firmware 

Using a USB Memory Device   

The Spectrum Master contains a feature that allows you to update its firmware by using a 
USB memory device. First, you must load the USB memory device with the firmware using 
Master Software Tools (MST). Review the section (in MST Help) that discusses this process. 
After the firmware is loaded onto the USB memory device, follow the instructions below to 
update the firmware on your Spectrum Master.

1. Insert the USB Memory Stick into the USB port.

2. Press the follow key sequence: Shift > System (8) > System Options > Reset > Update 
Firmware. The Load Firmware main menu key is displayed (Figure 5-9).

3. Press the Load Firmware main menu key to list the Firmware Update menu and the 
Update Application Firmware submenu key.

4. Press the Update Application Firmware submenu key, and the Firmware Update dialog 
opens (Figure 5-10).

Figure 5-9. Firmware Main Menu
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5. Highlight each of the save choices: Save None, Save User Data, and Save & Restore User 
Data. Read through each choice carefully and then select the desired save mode.

• Save None: No attempt will be made to save any user data.

• Save User Data: User data will be save to the selected external media device. 

• Save & Restore: User data will be saved to the selected external media device. 
The instrument will also attempt to restore the files to the instrument after the 
update. 

6. Press Enter to begin the firmware update process. To abort the process, press Esc, then 
choose another analyzer mode or power down.

Figure 5-10. Firmware Update Menu

Warning
If not enough memory space is available for all user data, then some data may be 
lost during this process.

Warning
If not enough memory space is available for all user data, then some data may be 
lost during this process.
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7. The Firmware Update dialog will query you to confirm the process by pressing Enter to 
continue or Esc to abort (Figure 5-11).

8. Select Enter and the firmware update process begins. The Firmware Update dialog 
displays the following message:

Updating firmware. Please Wait.

9. When complete, the instrument will reboot.

Update Firmware Using Master Software Tools

Refer to “Updating Instrument Firmware” on page 7-2 in Chapter 7, “Master Software Tools”.

Figure 5-11. Firmware Update Menu
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Chapter 6 — GPS (Option 31)

6-1 Introduction  
The Spectrum Master MS272xC is available with a built-in GPS receiver feature (Option 31) 
that can provide latitude, longitude, altitude, and UTC timing information. When GPS is 
actively locked to satellites, this information is saved with all saved measurements and can 
be displayed with Master Software Tools. This option also enhances frequency reference 
oscillator accuracy.

6-2 Setting Up GPS (Option 31)   
In order to acquire data from the GPS satellites, you must have line-of-sight to the satellites, 
or the antenna must be placed outside without any obstructions. In addition to Option 31, the 
Spectrum Master requires a GPS antenna, Anritsu part number 2000-1528-R.

Activating the GPS Feature

1. Attach the GPS antenna to the GPS Antenna connector on the top of the instrument.

2. Press the Shift key then the System (8) key on the numeric keypad to display the 
System menu.

3. Press the GPS submenu key to display the GPS menu.

4. Activate GPS by pressing the GPS, On/Off submenu key so that On is underlined. When 
GPS is first turned On, the GPS icon is displayed in red. 

5. Press the GPS Info submenu key to open the GPS Info window, which displays:

• Tracked Satellites

• Latitude

• Longitude

• Altitude

• UTC timing information

• Fix available

• Antenna Status

• Receiver Status

• GPS Antenna current and voltage

Figure 6-1. GPS Icon, Red
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6. When the GPS receiver is tracking at least 3 satellites, the GPS icon changes to green.   

After GPS location Fix is attained, the internal reference oscillator begins to correct its 
frequency to match the GPS standard. After the internal frequency is adjusted to match the 
GPS standard, the status is indicated by “GPS High Accuracy” showing in the Status menu, 
which is displayed on the left side of the measurement display. When the GPS feature is not 
enabled, the reference source displays either “Internal Standard Accuracy” or a user-selected 
external reference frequency in the Status menu.

Within three minutes of satellite acquisition, the reference oscillator will have an accuracy of 
better than 25 ppb (parts per billion). The OCXO internal standard accuracy is ±0.3 PPM. 
The correction factor applied to the internal OCXO allows the instrument to maintain GPS 
frequency accuracy for three days at better than 50 ppb, even when the instrument is 
obstructed from receiving signals from the GPS satellites.

In order to acquire data from the GPS satellites, you must have line-of-sight to the satellites, 
or the antenna must be placed outside with no obstructions.

Option 31 requires a GPS antenna, Anritsu part number 2000-1528-R.

Figure 6-2. GPS Icon, Green

Note

As long as 3 minutes may be required for the Ref Freq status to change to GPS 
High Accuracy in the Status menu, which is displayed on the left side of the 
measurement display.

To reset the GPS, press the Reset submenu key. The green GPS icon with a red 
cross appears when GPS satellite tracking is lost (refer to Figure 6-3). This occurs 
after being active (tracking three or more satellites). 

Figure 6-3. GPS Icon, Green with Red Cross
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Chapter 7 — Master Software Tools 

7-1 Introduction
This chapter provides a brief overview of Master Software Tools (MST), firmware update, and 
emergency repair procedures. For detailed information about Master Software Tools, refer to 
the MST Manual on the CD-ROM that was included with the Spectrum Master. The major 
sections of this chapter include:

• “Master Software Tools Overview” on page 7-1

• “MST Feature Overview” on page 7-1

• “Updating Instrument Firmware” on page 7-2

7-2 Master Software Tools Overview  
Anritsu Master Software Tools is a Microsoft Windows compatible program (for 
Windows 2000, Windows XP, and 64-bit Windows Vista) for transferring and editing saved 
measurements, markers, and limit lines to a PC. Master Software Tools will not function on 
earlier versions of the Microsoft Windows operating system. 

7-3 MST Feature Overview
Capturing or Retrieving Traces

MST includes a feature to capture the current screen and associated data from the test 
instrument to the Master Software Tools Graphic Display Editor window. Saved files on the 
test instrument can also be retrieved and displayed or edited with Master Software Tools.

Editing Graphs

MST can be used to change the scale, limit lines, and markers in a measurement through the 
Edit Graph button in the workspace toolbar, or through the Context Menus.

Context Menus

Context Menus are accessed by right-clicking the mouse on an active measurement screen in 
the Graphic Display Editor Window. Context Menu functions may include commands that are 
also available on the pull down menus and toolbar buttons, or functions, commands, and 
options specific to the active measurement window.

Overlaying Traces

Trace Math and Overlays allow for comparing multiple traces.

Folder Spectrogram

Folder Spectrogram provides a simulated three dimensional view of a large amount of data in 
one set of graphs.

3D Spectrogram View 
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The 3D Spectrogram function allows you to view a folder of measurement traces in true 
three dimensions: frequency, time, and amplitude. You can use markers to select or point out 
specific frequencies and amplitudes. With Signal ID, you can view specific types of signals 
and their signal-to-noise ratio (SNR). 3D Spectrogram requires Microsoft DirectX running on 
your PC.

Script Master

Script Master is an editor that is used to create files that set up measurement parameters 
and create automated test procedures that aid field technicians or field application engineers 
with measurement testing.

7-4 Installing MST
MST is provided on the CD-ROM that is included with the instrument. Insert the CD-ROM 
into a PC to run the installer. Follow the onscreen instruction.

7-5 Updating Instrument Firmware  
1. Connect the Spectrum Master to a PC by using USB or Ethernet. Refer to the Master 

Software Tools (MST) User Guide (on the CD-ROM) for information regarding 
connecting your Spectrum Master to a PC.

If you are using USB, then refer to Section 5-6 “Update Firmware” on page 5-9. If you 
are using Ethernet, then continue with Step 2.

2. Run Master Software Tools

3. From the Connection menu:        

• for a USB Connection, Select Connect – USB.

• for an Ethernet Connection:

a. Enter the IP Address of your Spectrum Master by first clicking 
Enter IP Address…

b. Then click Connect – Ethernet: xxx.xxx.xxx.xxx

• In either type of connection, the connection type is displayed in the toolbar. 

4. From the Tools menu, click Product Updates.  

Figure 7-1. IP Address in Connection Button
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The Product Updates window opens. 

5. Notice the differences in the two Product Updates windows in Figure 7-3 and 
Figure 7-4.

• File Status Ready

In Figure 7-3, the status of the highlighted file is Ready, and the Install to Unit 
button is active. You can immediately click Install to Unit to update your 
Spectrum Master with the new firmware. 

• File Status Available

In Figure 7-4, the status of the highlighted file is Available, and the Install to Unit 
button is gray and inactive. This means that the updated file is on the Anritsu 
Product Support Web site and needs to be downloaded to your PC. After the file 
has been downloaded and placed on your PC, its status changes to Ready, and the 
Install to Unit button becomes active.

Figure 7-2. Tool Menu: Product Updates Command
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Note
Screen captured images are provided as examples. The images shown on your 
instrument may differ from the examples in this user guide. 

Figure 7-3. Product Updates Window: Status Ready
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File Status Ready:

1. Check that the file status is Ready and that the Install to Unit button is active.

2. Click the Install to Unit button. Your Spectrum Master is updated with the new 
firmware.

File Status Available:

1. Check that the file status is Available.

2. Click Retrieve File to download the file from the Web site to your PC.

3. Check that the file status changes to Ready.

4. Click the Install to Unit button. Your Spectrum Master is updated with the new 
firmware.

Figure 7-4. Product Updates Window: Status Available
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File Not Listed:

You might open the Product Updates window and not find the file that you are looking for. In 
that case: 

1. Click the Check for Updates button. Master Software Tools checks for the latest updates 
at the Anritsu Product Support Web Site. New updates that are found are listed in the 
file menu. 

2. Click the Retrieve File button. The file is transferred from the Web site to your PC.

3. After the status changes to Ready, click the now-active Install to Unit button. Your 
Spectrum Master is updated with the new firmware.

Update Problems 

If you do not find the latest update, or if you encounter a problem with updating the 
firmware, then contact Anritsu. Internet links to worldwide Anritsu locations can be 
found at the following URL:

http://www.anritsu.com/Contact.asp 

Update Firmware by Using a USB Device

Refer to the Master Software Tools (MST) User Guide (on the CD-ROM) for information 
regarding connecting your Spectrum Master to a PC. Also refer to Section 5-6 “Update 
Firmware” on page 5-9.

http://www.anritsu.com/Contact.asp
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Appendix A — Measurement Guides

A-1 Introduction 
This appendix provides a list of supplemental documentation for Spectrum Master features 
and options. The measurement guides are available as PDF files on the Documentation disc 
or the Anritsu web site. The Technical Data Sheets are available on the Anritsu web site.

A-2 Documents, Firmware, Supplemental Information 
Documents and Firmware may also be downloaded. 

Table A-1. Analyzers and Analyzer Options (Sheet 1 of 2)

Spectrum Master Feature (Required Option)
Related Document 
(Part Number)

Spectrum Analyzer

Interference Analyzer (0025)

Channel Scanner (0027)

Zero-Span IF Output (0089)

AM/FM/PM Analyzer (0509)

Spectrum Analyzer 
Measurement Guide 
(10580-00244)

High-Accuracy Power Meter (0019)
Power Meter 
Measurement Guide 
(10580-00240)

GSM/GPRS/EDGE RF Signal Analyzer (0040)

GSM/GPRS/EDGE Demodulated Signal Analyzer (0041)

W-CDMA/HSDPA RF Signal Analyzer (0044)

W-CDMA Demodulated Signal Analyzer (0045)

W-CDMA/HSDPA Demodulated Signal Analyzer (0065)

W-CDMA/HSDPA Over-the-Air Signal Analyzer (0035)

TD-SCDMA/HSDPA RF Signal Analyzer (0060)

TD-SCDMA/HSDPA Demodulated Signal Analyzer (0061)

TD-SCDMA/HSDPA Over-the-Air Signal Analyzer (0038)

LTE RF Measurements (0541)

LTE Modulation Measurement (0542)

LTE Over-the-Air Measurements (0546)

TD-LTE RF Measurements (0551)

TD-LTE Modulation Measurement (0552)

TD-LTE Over-the-Air Measurements (0556)

3GPP Signal Analyzer 
Measurement Guide 
(10580-00234)
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cdmaOne/CDMA2000 1X RF Signal Analyzer (0042)

cdmaOne/CDMA2000 1X Demodulated Signal Analyzer (0043)

cdmaOne/CDMA2000 1X Over-the-Air Signal Analyzer (0033)

CDMA2000 1xEV-DO RF Signal Analyzer (0062)

CDMA2000 1xEV-DO Demodulated Signal Analyzer (0063)

CDMA2000 1xEV-DO Over-the-Air Signal Analyzer (0034)

3GPP2 Signal Analyzer 
Measurement Guide 
(10580-00235)

IEEE 802.16 Fixed WiMAX RF Signal Analyzer (0046)

IEEE 802.16 Fixed WiMAX Demodulated Signal Analyzer (0047)

IEEE 802.16 Mobile WiMAX RF Signal Analyzer (0066)

IEEE 802.16 Mobile WiMAX Demodulated Signal Analyzer (0067)

IEEE 802.16 Mobile WiMAX Over-the-Air Signal Analyzer (0037)

WiMAX Signal Analyzer 
Measurement Guide 
(10580-00236)

Performance Specifications, Spectrum Master Technical Data Sheets

   MS2722C

   MS2723C

   MS2724C

   MS2725C

   MS2726C

11410-00529

11410-00524

11410-00525

11410-00525

11410-00526

Table A-2. Supplemental Documents

Document Type Part Number

Performance Specifications, Spectrum Master Technical Data Sheets

   MS2722C

   MS2723C

   MS2724C

   MS2725C

   MS2726C

 

11410-00529

11410-00524

11410-00525

11410-00525

11410-00526

Spectrum Master Programming Manual 10580-00278

Spectrum Master Maintenance Manual 10580-00279

Table A-1. Analyzers and Analyzer Options (Sheet 2 of 2)

Spectrum Master Feature (Required Option)
Related Document 
(Part Number)
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Table A-3. Additional Instrument Supplements

Supplement Type Part Number

Handheld Instruments Documentation Disc 10920-00060

Computer Software Application
Master Software Tools CD-ROM
(May also be downloaded)

2300-498 



Documents, Firmware, Supplemental Information

A-4 PN: 10580-00277  Rev. E Spectrum Master UG



Spectrum Master UG PN: 10580-00277  Rev. E B-1

Appendix B — Error Messages

B-1 Introduction 
This chapter provides a list of information and error messages that could be displayed on the 
MS272xC Spectrum Master. If any error condition persists, then contact your local Anritsu 
Service Center (http://www.anritsu.com/Contact.asp).

B-2 Self Test or Application Self Test Error Messages 
Overall Status FAILED 

One or more elements of the System or Application Self Test has failed. Refer to the other 
pass fail tests listed below to determine which specific test failed.

ADC Self Test FAILED

The Analog to Digital converter failed to return an answer. Insure that the battery level is 
adequate for operation or that the temperature is within acceptable limits. Reset to factory 
defaults with either Factory Defaults, ESC+ON, or MASTER RESET, System+ON. 
Caution: Use of MASTER RESET, System+ON, will erase all user saved setups and 
measurement traces and return the unit to a fully Factory Default condition. If the error 
persists, then contact your Anritsu Service Center.

DDC FAILED 

The Digital Down Converter failed to return a value. Insure that the battery level is adequate 
for operation or that temperature is within acceptable limits. Reset to factory defaults with 
either Factory Defaults, ESC+ON, or MASTER RESET, System+ON. Caution: Use of 
MASTER RESET, System+ON, will erase all user saved setups and measurement traces and 
return the unit to a fully Factory Default condition. If the error persists, then contact your 
Anritsu Service Center.

Lock Test FAILED

One or more Phase Lock Loops Failed to properly achieve Lock Status. Insure that the 
battery level is adequate for operation or that temperature is within acceptable limits. Reset 
to factory defaults with either Factory Defaults, ESC+ON, or MASTER RESET, System+ON. 
Caution: Use of MASTER RESET, System+ON, will erase all user saved setups and 
measurement traces and return the unit to a fully Factory Default condition. If the error 
persists, then contact your Anritsu Service Center.

Over Power FAILED

http://www.anritsu.com/Contact.asp
http://www.anritsu.com/Contact.asp
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RF Power applied to the input connector is too high. Remove or reduce the input power or add 
additional attenuation. Sometimes out of band frequencies may be present that can cause an 
Over Power Error. In highly rich RF environments it may be necessary to add an external 
band pass filter to reduce unwanted interference. See the accessories section for a list of 
available band pass filters from Anritsu. Out of band frequencies can often be detected by 
increasing the Span to maximum in the peak detect mode of operation. Another resolution 
may be to reset to factory defaults with either Factory Defaults, ESC+ON, or MASTER 
RESET, System+ON. Caution: Use of MASTER RESET, System+ON, will erase all user 
saved setups and measurement traces and return the unit to a fully Factory Default 
condition. If the error persists, then contact your Anritsu Service Center.

Over Power Start FAILED

RF Power applied to the input connector is too high at turn on. See Over Power FAILED error 
above.

Mixer Saturation:  Increase Attenuation

or

Mixer Overdrive FAILED

Too much power applied with too little Attenuation. Increase attenuation. Sometimes even 
out of band frequencies may be present that would cause a Mixer Overdrive Error. In highly 
rich RF environments it may be necessary to add an external band pass filter to reduce 
unwanted interference. See the accessories section for a list available band pass filters from 
Anritsu. Out of band frequencies can often be detected by increasing the SPAN to maximum 
in peak detect mode of operation. Another resolution may be to Reset to factory defaults with 
either Factory Defaults, ESC+ON, or MASTER RESET, System+ON. Caution: Use of 
MASTER RESET, System+ON, will erase all user saved setups and measurement traces and 
return the unit to a fully Factory Default condition. If the error persists, then contact your 
Anritsu Service Center.

B-3 Operation Error Messages 
ADC Over range: Increase Reference Level

Input signal is too large for the Analog to Digital converter to process. Increase the internal or 
external attenuation or, if using Auto attenuation, then increasing the Reference Level 
should resolve the error. See also the “Mixer Overdrive FAILED” error (described previously) 
for information on Out of Band RF power.

Calibrator Reading Error

Calibration reference source is not providing quality signal. Insure that the battery level is 
adequate for operation or that temperature is within acceptable limits. Reset to factory 
defaults with either Factory Defaults, ESC+ON, or MASTER RESET, System+ON. 
Caution: Use of MASTER RESET, System+ON, will erase all user saved setups and 
measurement traces and return the unit to a fully Factory Default condition. If the error 
persists, then contact your Anritsu Service Center.

Fatal Error
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Usually caused by a failure to communicate with one section or another. Sometimes resolved 
by restarting the unit or by Factory Defaults, ESC+ON, resetting of the unit. Under extreme 
cases the use of MASTER RESET, System+ON, may resolve the issue. Caution: Use of 
MASTER RESET, System+ON, will erase all user saved setups and measurement traces and 
return the unit to a fully Factory Default condition. If the error persists, then contact your 
Anritsu Service Center.

Trace not saved. Please wait for complete sweep and try again.

Attempted to save a measurement trace before the sweep had completed at least once. Wait 
for at least one complete sweep and try to save again. 

Measurement not valid in Zero Span

Attempt was made to make an automated measurement that requires more than ZERO 
SPAN to accomplish. An example would be Occupied Bandwidth measurement.

The Freq range of the Antenna is invalid for this setup. Please select another Antenna

Choose a start and stop frequency that is within the defined frequency range for the selected 
antenna compensation table. See also Master Software Tools for creation and Upload of 
Antenna correction files.

Minimum permitted Sweep time is 50 µs

An attempt was made to set the minimum Sweep time to less than 50 µs.

Invalid Attenuation for Preamp

The only valid attenuation settings while the Preamp is operational are 0 dB, 5 dB and 10 dB. 
All other settings attempted by the user will result in this message. Select 0 dB, 5 dB or 10 dB 
or select AUTO Attenuation to let the system determine the correct setting based on the 
reference level selected.

Valid Attenuations with Preamp on are 0 dB, 5 dB and 10 dB

Same as above

Unable to add additional limit points. %d is the maximum.

Attempted to add an additional limit line point beyond the maximum number of allowed 
points.

Use Demod type USB or LSB to use Beat Frequency Osc  

An attempt to use the Beat Frequency Oscillator while not in Upper or Lower Sideband 
Demodulation mode.

Trace A/B/C has no data to view

Attempt to turn on or VIEW a trace that has never had data recalled into this trace location. 
Refer to Recall Trace section for instructions on how to recall stored measurement traces into 
either Trace A, B or C.

Locking to Internal Ref failed

Switching from an external frequency reference to the internal reference has failed. Some 
additional warm up time may be needed if the unit has been on external reference for a long 
time or if the unit is not warmed up enough.

Locking to External Ref failed; Lock attempt Failed
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Switching from an internal frequency reference to the external reference has failed. Verify 
that the correct external reference frequency value has been selected from the list of valid 
external reference frequencies. Verify that the level of the external reference frequency is at 
least 1vp-p.

Fatal error, EEPROM failed

Hardware communications between modules has failed. Insure that the battery level is 
adequate for operation or that temperature is within acceptable limits. Reset to factory 
defaults with either Factory Defaults, ESC+ON, or MASTER RESET, System+ON. 
Caution: Use of MASTER RESET, System+ON, will erase all user saved setups and 
measurement traces and return the unit to a fully Factory Default condition. If the error 
persists, then contact your Anritsu Service Center.
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Fatal error, no SPA board connected

Hardware communications between modules has failed. Insure that the battery level is 
adequate for operation or that temperature is within acceptable limits. Reset to factory 
defaults with either Factory Defaults, ESC+ON, or MASTER RESET, System+ON. 
Caution: Use of MASTER RESET, System+ON, will erase all user saved setups and 
measurement traces and return the unit to a fully Factory Default condition. If the error 
persists, then contact your Anritsu Service Center.

Operation not Permitted in Recall Mode

Attempted to perform an operation on a recalled trace. Many operations are valid only on a 
live or active trace.

Cannot change scale in Linear mode

Linear display mode of operation does not support a scaling change in the same manner as 
the Log display mode.

Cannot turn on delta marker because Ref Marker is invalid

Delta markers cannot be enabled unless the primary marker is within the displayed span.

Cannot turn on delta marker because Ref Marker is a counter Marker

Delta markers cannot be enabled unless the primary marker is NOT a counter Marker. Turn 
off the Counter Marker mode of marker operation to use Delta Marker.

Current Marker is not ON

Attempted to use a marker mode or feature for a marker that is not enabled. Turn on the 
appropriate marker to use this function or switch to a marker that is already enabled.

Marker must be ON to Use the feature

Attempted to use a marker mode or feature for a marker that is not enabled. Turn on the 
appropriate marker to use this function or switch to a marker that is already enabled.

Triggering valid only in Zero Span

External triggering can only be used while the SPAN is set to 0 (zero) 

Cannot change Modes for Recalled/Inactive Traces

Detection modes or other elements such as RBW/VBW, averaging, and so forth, cannot be 
altered on a recalled trace. The trace is displayed with the same parameters in which it was 
saved.

Cannot change average for Recalled/Inactive Traces 

Cannot set Delta Detection modes or other elements such as RBW/VBW, averaging, and so 
forth, cannot be altered on a recalled trace. The trace is displayed with the same parameters 
in which it was saved.

Pretune Calibration Table fault 

Ensure that the battery level is adequate for operation or that temperature is within 
acceptable limits. Reset to factory defaults with either Factory Defaults, ESC+ON, or 
MASTER RESET, System+ON. Caution: Use of MASTER RESET, System+ON, will erase 
all user saved setups and measurement traces and return the unit to a fully Factory Default 
condition. If the error persists, then contact your Anritsu Service Center.
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Lock failed during initialization

One or more of the Phase Lock Loops failed to achieve lock status during startup. Insure that 
the battery level is adequate for operation or that temperature is within acceptable limits. 
Reset to factory defaults with either Factory Defaults, ESC+ON, or MASTER RESET, 
System+ON. Caution: Use of MASTER RESET, System+ON, will erase all user saved 
setups and measurement traces and return the unit to a fully Factory Default condition. If 
the error persists, then contact your Anritsu Service Center.

Reference LVL Cal is OFF

Factory Calibration is OFF. Insure that the battery level is adequate for operation or that the 
temperature is within acceptable limits. Reset to factory defaults with either Factory 
Defaults, ESC+ON, or MASTER RESET, System+ON. Caution: Use of MASTER RESET, 
System+ON, will erase all user saved setups and measurement traces and return the unit to 
a fully Factory Default condition. If the error persists, then contact your Anritsu Service 
Center.

IF Cal is OFF

Factory Calibration is OFF. Insure that the battery level is adequate for operation or that the 
temperature is within acceptable limits. Reset to factory defaults with either Factory 
Defaults, ESC+ON, or MASTER RESET, System+ON. Caution: Use of MASTER RESET, 
System+ON, will erase all user saved setups and measurement traces and return the unit to 
a fully Factory Default condition. If the error persists, then contact your Anritsu Service 
Center.

Cannot set Delta Mkr Freq to Demod Freq 

Marker to Demod frequency is only available with a primary marker as the selected marker.

Fan Failure

The system has determined that the fan should be running due to the internal temperature of 
the unit, but cannot detect that the fan is actually running.
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It is important to keep the fan inlet and exhaust ports clear of obstructions. The cooling fan 
will vary the speed in relation to the internal temperature of the instrument. The fan will 
turn on at low speed when the internal temperature of the instrument reaches 44ºC, and will 
increase the fan speed to maximum at 54ºC. As the internal temperature of the instrument 
decreases, the fan will reduce speed until the temperature reaches 39ºC, at which point the 
fan will turn off.

High Temp Warning

The internal temperature has reached an excessive level, 85ºC. Verify that the ventilation 
openings are unobstructed and that the fan is running. Internal temperatures may be 
manually verified by using the SELF TEST function. Turn off the unit and allow the 
temperature to cool down. If the fault is not resolved and if the internal temperature reaches 
90ºC, then a countdown of 10 seconds will begin to give the user a chance to save the current 
setup before it will turn itself off (before internal temperatures can cause any damage). If the 
error persists after removing any obstructions and allowing the unit to cool, then reset to the 
factory defaults with either Factory Defaults, ESC+ON. Caution: Use of MASTER RESET, 
System+ON, will erase all user saved setups and measurement traces and return the unit to 
a fully Factory Default condition. If the error persists, then contact your Anritsu Service 
Center.

Copy failed. Please check External USB Memory

Attempt to copy user saved data to the external USB Flash drive has failed. Do not attempt to 
remove or power down the unit before the copy has completed. Be sure that the USB memory 
device is not already full and that it is fully inserted into the USB connector.

PLL Lock Fail

Phase Lock Loop failed to lock. 

Trace not saved. Please wait for complete sweep and try again.

Attempted to save a measurement trace before the sweep had completed at least once. Wait 
for at least one complete sweep and try to save again.

Figure B-1.  Fan Speed versus Temperature
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Appendix C — LAN and DHCP

C-1 Introduction 
This appendix describes network connections for the MS272xC Spectrum Master. 

C-2 Ethernet Configuration

LAN Connection 

The RJ-45 connector is used to connect the Spectrum Master to a local area network. 
Integrated into this connector are two LEDs. The amber LED shows the presence of a 
10 Mbit/s LAN connection when on, and a 100 Mbit/s LAN connection when off. The green 
LED flashes to show that LAN traffic is present. The instrument IP address is set by pressing 
the Shift key, then the System (8) key followed by the System Options submenu key and the 
Ethernet Config submenu key. The instrument Ethernet address can be set automatically using 
DHCP, or manually by entering the desired IP address, gateway address, and subnet mask. 

Dynamic Host Configuration Protocol (DHCP) is an Internet protocol that automates the 
process of setting IP addresses for devices that use TCP/IP, and is the most common method 
of configuring a device for network use. To determine if a network is set up for DHCP, connect 
the MS272xC to the network and select DHCP protocol in the Ethernet Config menu. 

Turn the Spectrum Master off, and then on. If the network is set up for DHCP, then the 
assigned IP address should be displayed briefly after the power up sequence.

Note

An active Ethernet cable must be connected to the instrument before it is turned 
ON in order to enable the Ethernet port for DHCP or for a static IP address.

Depending upon local conditions, the port may remain enabled when changing 
from DHCP to static IP address, when changing from static IP address to DHCP, 
or when temporarily disconnecting the Ethernet cable.

If the port becomes disabled, then ensure that an active Ethernet cable is attached 
to the instrument before cycling the power OFF and back ON.
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To display the IP address with the instrument on, press the Shift key, then the System (8) 
key, then the System Options submenu key and the Ethernet Config submenu key. The IP address 
will be displayed as shown in Figure C-1. The image on the display panel of your 
Spectrum Master may differ from the image shown here. 

Figure C-1. IP Address Assigned Using DHCP
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Ethernet Config 

Press this submenu key to display the Ethernet submenu and to open the Ethernet Editor 
dialog box in order to set the IP address of the instrument. 

Figure C-2. Setting IP Address Manually



Ethernet Configuration

C-4 PN: 10580-00277  Rev. E Spectrum Master UG

Ethernet Menu  

Key Sequence: Shift, System (8) > System Options > Ethernet Config 

Type
Manual DHCP: Press this submenu key to select whether the address will 
be entered manually, or will be supplied automatically by a network DHCP 
server. If Manual is selected, then use the submenu keys or the Left/Right 
arrow keys to select the field that is to be modified. Use the keypad, the 
Up/Down arrow keys, or the rotary knob to enter the input. Press Enter to 
accept the changes, or press the Esc key to return to normal operation 
without changing anything.

Field
IP G-Way Sub: Press this submenu key to select the desired Internet 
Protocol Property to be edited.

First Octet: Moves the cursor to the left most column of the selected IP 
properties field.

Second Octet: Moves the cursor to the second column from the left of the 
selected IP properties field.

Third Octet: Moves the cursor to the third column from the left of the 
selected IP properties field.

Fourth Octet: Moves the cursor to the forth column from the left of the 
selected IP properties field.

Figure C-3. Ethernet Menu

Ethernet

Type

Manual         DHCP

Field

IP     G-Way    Sub

First Octet

Second Octet

Third Octet

Fouth Octet
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C-3 DHCP 
DHCP stands for Dynamic Host Configuration Protocol. It is a protocol that allows a server to 
dynamically assign IP addresses to devices that are connected to the network. Most networks 
include a DHCP server to manage IP addresses. When a DHCP server is available on the 
network, DHCP is the preferred IP address assignment mode.

When using DHCP, no setup is required to lease and use a dynamic IP address. In a dynamic 
IP operation, the IP address in use may change from use to use. The DHCP server hands out 
IP addresses on a first come, first served basis. As soon as the device is disconnected from the 
network, the IP address that it was using becomes available to lease to the next unit that 
requests an IP address. Normally, some amount of lag time is present on the DHCP server 
end, so if the device is connected again reasonably soon, then it may end up with the same 
address. 

When a DHCP server is not available, a Static IP address can be used. A Static IP address is 
a fixed address. After being set, it will always remain the same, and care must be taken to not 
conflict with other equipment on the network.

When using a static IP address on an established network, always request the Static IP 
address from the network administrator. Randomly choosing a Static IP address on an 
established network may result in duplicate IP addresses or other conflicts.

Three parameters must be set prior to using a Static IP address:

IP Address  

This is the Static IP address on the network.

Default Gateway   

Often when a static IP address is assigned, a default gateway is also identified. If the 
default gateway is unknown, then type in the Static IP address so that the Static IP 
address and Default Gateway are the same number.

Subnet Mask   

This parameter is usually extracted from the Static IP address based on the class of the 
address and determines the destination of any broadcast messages that might be sent 
from the instrument. It can be customized if necessary. The subnet mask may also be 
provided with the Static IP address.

Example 1

In this example, a Static IP address has been chosen because no network DHCP service is 
available. The instrument is connected to the network port on the PC with a crossover 
Ethernet cable (not included). This is also referred to as Direct Connect:

IP Address: 10.0.0.2

Default Gateway: 10.0.0.2

Subnet Mask: 255.255.0.0
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Example 2

In this example, the Static IP address has been assigned with an associated gateway and 
subnet mask:

IP Address: 153.56.100.42

Default Gateway: 153.56.100.1

Subnet Mask: 255.255.252.0

C-4 ipconfig Tool 
A few tools that are built into the Microsoft Windows operating system can assist in making 
some determinations about the network to which the PC is connected. Typing ipconfig at a 
command prompt produces a display of information about the in-use parameters of the PC 
and its network connection. Following is an example of the typical results expected: 

Y:\>ipconfig

Windows 2000 IP Configuration

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix. : us.anritsu.com

IP Address. . . . . . . . . . . . : 172.26.202.172

Subnet Mask . . . . . . . . . . . : 255.255.252.0

Default Gateway . . . . . . . . . : 172.26.200.1

Note
The ipconfig display does not report whether the information is from a DHCP 
server or from a Static IP setup.
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C-5 Ping Tool  
Another tool that can find out if a selected IP address is already on the network is ping. Ping 
is a harmless way to determine if an address is found on the network, and (if it is found) to 
receive a reply. Basically, the ping function sends out a request to a specific address to 
determine if a computing device is connected to the network at that address. If a valid 
connection is found, then a copy of the signal (that was sent) is returned. If a connection is not 
found, then the response is “request timed out”, which means that no reply was received from 
that IP address. 

Y:\>ping 172.26.202.172

Pinging 172.26.202.172 with 32 bytes of data:

Reply from 172.26.202.172: bytes=32 time<10ms TTL=128

Reply from 172.26.202.172: bytes=32 time<10ms TTL=128

Reply from 172.26.202.172: bytes=32 time<10ms TTL=128

Reply from 172.26.202.172: bytes=32 time<10ms TTL=128

Ping statistics for 172.26.202.172:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),

Approximate round trip times in milliseconds:

Minimum = 0 ms, Maximum = 0 ms, Average = 0 ms
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